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RESUMEN

El presente trabajo es un marcador de tiempo programable que se ha
disefiado utilizando un microcontrolador PIC16F84, con una capacidad de
guardar diez tiempos de programacion en la memoria EEPROM que es una
pequefia area de memoria de datos de lectura y escritura no volatil, gracias a la
cual, un corte del suministro de la alimentacion no ocasionara la pérdida de la
informacion, que estard disponible al reinicializarse el programa marcador de

tiempo.

Gracias a sus excelentes caracteristicas: bajo precio, reducido consumo,
pequefio tamafio, gran calidad, fiabilidad y abundancia de informacion, al
PIC16F84 lo convierten en comodo y rapido de utilizar en el marcador de

tiempo programable.

El trabajo de investigacién cuenta con un marco tedrico el mismo que ha
servido de apoyo para conocer con mayor claridad los conceptos basicos y

modo de funcionamiento del PIC16F84.

El colegio Jan Amds Comenius en la actualidad dispone de un timbre
eléctrico para la realizaciéon del cambio de horas académicas, lo cual induce a
errores involuntarios, producidos por razones como olvidos, relojes no
sincronizados de las personas que tocan el timbre, etc. Ante esta situacion se
crea la necesidad de automatizar el cambio de horas mediante un sistema

electronico, el mismo que se pone en consideracion en el presente trabajo.

Con la propuesta de implementar este marcador de tiempo programable
en el Colegio particular bilingie “Jan Amoés Comenius” de la ciudad de
Latacunga automatizariamos el control de horas académicas, dando paso a la
implementacion de un sistema que permita realizar esta actividad de manera
auténoma y con la gran ventaja de cada cambio de hora se realice con total
exactitud.



Con el marcador de tiempo programable se evitara que cada maestro se
tome un tiempo adicional de su materia esto para evitar los inconvenientes con

el siguiente maestro que viene a impartir su hora clase.



INTRODUCCION

En la actualidad nos desarrollamos en un mundo competitivo en el cual
nos exige siempre estar a la par del desarrollo tecnoldgico, en donde se debera

estar cambiando constantemente, caso contrario se deja de ser competitivo.

Los microcontroladores se utilizan en circuitos electronicos comerciales
desde hace muchos afios de forma masiva, debido a que permiten reducir el
tamafio y el precio de los equipos. Un ejemplo de éstos son los teléfonos

moviles, las camaras de video, la transmision por satélite y otros.

En los ultimos afios se ha facilitado enormemente el trabajo con los
microcontroladores al bajar los precios, aumentar las prestaciones y simplificar

los montajes.

Diversos fabricantes ofrecen amplias gamas de microcontroladores para
todas las necesidades. Pero sin duda, hoy en dia los microcontroladores mas

aceptados para disefios son los microcontroladores PIC.

Entre los microcontroladores PIC se destaca el PIC16F84 cuya
simplicidad, prestaciones, facilidad de uso y precio lo han convertido en el mas
popular de los microcontroladores, siendo un chip ordinario de 18 patillas, cuya
estructura contiene mucha de la tecnologia que se necesita conocer para

entender los sistemas de control con microprocesadores.



PLANTEAMIENTO DEL PROBLEMA:

El Colegio particular bilingtie “Jan Amos Comenius” de la ciudad de
Latacunga crea la necesidad de automatizar el control de inicio y fin de las
horas académicas, dando esto lugar a la implementacién de un sistema que
permita realizar esta actividad de modo que no se requiera la intervencion

humana, y que ademas sea de una precision adecuada.

Por otro lado es necesario que el sistema en mencidon tenga la
posibilidad de modificar los inicios y fines de hora programados sin la
intervencidon de técnicos en sistemas electronicos o0 especialistas en

programacion.

Surge entonces la posibilidad de llevar a cabo este proyecto mediante la
realizaciéon de un proyecto de grado que se espera sea beneficioso para todos

los involucrados en el mismo.



JUSTIFICACION:

En la actualidad se hace accesible inclusive en las tareas mas cotidianas
la automatizacién de ciertas actividades y procesos, debido a los bajos costos
especialmente de los circuitos integrados digitales, y por supuesto la alta

tecnologia con la que estos se construyen.

Hace apenas pocos afios no era posible pensar en un pequefio
microcomputador casi completo e integrado monoliticamente en un solo circuito
de 18 patillas, y que ademasl disponga de las mejores caracteristicas de
varios de los complejos sistemas computacionales de entonces, y a costos muy

accesibles.

Con estas facilidades a nuestro alcance, resulta plenamente justificado
liberar a una persona de la rutinaria tarea de mirar el reloj para avisar mediante

un timbrado del inicio o culminacién de una hora académica.

Con la automatizacion de esta actividad ademas se lograra mejorar la
precision con la que se realizaran estos avisos y de este modo no perjudicar el
tiempo que tienen los alumnos para el estudio, asi como su tiempo libre

(recreo).



OBJETIVOS:

OBJETIVO GENERAL:

Implementar un sistema automatico para el control de las horas

académicas en el Colegio particular bilingte “Jan Amos Comenius”.
OBJETIVOS ESPECIFICOS:

. Solucionar un problema concreto en la mencionada Institucién Educativa.

. Familiarizar con el microcontrolador PIC16F84.

. Aprender a usar los microcontroladores en la implementacion de
pequefios sistemas de control automatico.

. Conseguir tiempos de programacion en el cual se pueda ingresar datos de
acuerdo a la necesidad.

. Efectuar un sistema audible que permita a los docentes informar el inicio y
fin de su hora clase.

. Elaborar un manual de operacion que permita usar el sistema desarrollado
a una persona gue no tenga conocimiento de electrénica y concretamente

de sistemas digitales.



ALCANCE:

Con el presente proyecto se pretende solucionar un problema concreto
como es la automatizacion del control de las horas académicas en el Colegio
particular bilingie “Jan AmdOs Comenius” mediante la utilizacion de un

microcontrolador como es el PIC16F84.

El presente trabajo servira como fuente de informacién y consulta para
los futuros alumnos de la carrera de Avidnica, asi como de todos los

interesados en el tema.

Ademés se elaborard un manual de operacion para que cualquier

persona pueda usarlo.



CAPITULO |

MARCO TEORICO

1.1. REVISION DE LOS MICROCONTROLADORES

Los microcontroladores estan conquistando el mundo. Estan presentes
en el trabajo, en la casa y en la vida, en general. Se pueden encontrar
controlando el funcionamiento de los ratones y teclados de los computadores,
en los teléfonos, en los hornos microondas y los televisores del hogar. Estos
diminutos computadores, que gobernaran la mayor parte de los aparatos se
fabrican y usamos los humanos.

Un microcontrolador es un circuito integrado de alta escala de
integracion que incorpora la mayor parte de los elementos que configuran un

controlador.
1.1.1. MICROCONTROLADORES PIC

Un microcontrolador es un circuito integrado programable que contiene
todos los componentes necesarios para controlar el funcionamiento de una

tarea determinada, como un marcador de tiempo, un sistema de alarmas, etc.

El microcontrolador consta de una memoria donde almacena el
programa que gobierna el funcionamiento del mismo ya una vez programado

solo sirve para realizar la tarea asignada.

Cada tipo de microcontrolador sirve para una serie de casos y es el
disefiador del sistema quien debe decidir cual es el microcontrolador mas

idéneo para cada uso.

Los PIC son una familia de microcontroladores que han tenido una gran
aceptacion y desarrollo en los Ultimos afios gracias a que sus buenas

caracteristicas, bajo precio, reducido consumo, pequefio tamafo, gran calidad,



fiabilidad y abundancia de informacion, lo convierten en muy facil, comodo y

rapido de utilizar.

La frecuencia de trabajo del microcontrolador puede llegar hasta los 20
MHz con su nueva version PIC 16F84A-20.

1.1.2. ALIMENTACION DE UN PIC16F84

Un microcontrolador PIC16F84 se alimenta con 5 voltios aplicados
entre los pines Vbp y Vss que son respectivamente, la alimentacion y la masa

del chip.

El consumo de corriente para el funcionamiento del microcontrolador
depende de la tension de alimentacion, de la frecuencia de trabajo y de la

carga que soporta sus salidas, siendo del orden de unos pocos miliamperios.

El circuito de alimentacion del microcontrolador debe tratarse como el de
cualquier otro dispositivo digital, debiendo conectar un condensador de

desacoplo de unos 100 nF lo mas cerca posible de los pines de alimentacion.
1.1.3. PUERTOS DE ENTRADA/SALIDA

El microcontrolador se comunica con el mundo exterior a través de los

puertos.

Los puertos se pueden configurar como entrada para recibir datos o

como salida para gobernar dispositivos externos (figura 1.1)
El PIC16F84 tiene dos puertos.

e El Puerto A con 5 lineas, pines RAO a RA4.
e El Puerto B con 8 lineas, pines RBO a RB7.
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Figura 1.1 Distribucion de pines en el PIC16F84

Cada linea puede ser configurada como entrada o salida, independiente

una de otra, segun se programe.

Las lineas son capaces de entregar niveles TTL cuando la tension de
alimentacion aplicada en VDD es de 5V. La méaxima capacidad de corriente de

cada una de ellas es:

25 mA, cuando el pin esta a nivel bajo, es decir, cuando consume
corriente. Sin embargo, las sumas de las intensidades por las 5 lineas del
Puerto A no puede exceder de 80 mA, ni la suma de las 8 lineas del Puerto B

puede exceder de 150mA.

20 mA, cuando el pin esta a nivel alto, es decir, cuando proporciona
corriente. Sin embargo, la suma de la intensidad por las 5 lineas del Puerto A
no puede exceder de 50 mA, ni la suma de los 8 lineas del Puerto B puede
exceder de 100mA.

1.1.4. OSCILADOR

Todo microcontrolador requiere de un circuito que le indica la velocidad

de trabajo a este se le conoce como oscilador o reloj.

10



Este oscilador genera una onda cuadrada de alta frecuencia que se
utiliza como sefal para sincronizar todas las operaciones del sistema, este
circuito es simple pero de vital importancia para el buen funcionamiento del

sistema.

Generalmente todos los componentes de reloj se encuentran integrados
en el propio microcontrolador y tan solo se requiere unos pocos componentes
externos, como un cristal de cuarzo o una red RC, para decir la frecuencia de

trabajo.

Los pines OSC1 y OSC2 son las lineas utilizadas para conectar el
oscilador, se permite cinco tipos de osciladores para definir la frecuencia de

funcionamiento:

XT. Cristal de cuarzo.

* RC. Oscilador con resistencia y condensador.

» HS. Cristal de alta velocidad.

» LP. Cristal para baja frecuencia y bajo consumo de potencia.

e Externa. Cuando se aplica una sefial de reloj externa.

Para el proyecto a realizar se ha estimado conveniente utilizar el
oscilador XT, por la facilidad de haberlo utilizado antes y est4 basado en el

oscilador a cristal de cuarzo.

Es un oscilador estandar que permite una frecuencia de reloj muy
estable comprendida entre 100KHz Y 4 MHz.

El condensador debe ir acompafiado de dos condensadores entre 15 y

33 pF como se ilustra en la figura 1.2.
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Figura 1.2 Configuracion de un oscilador XT

Si se comprueba con un osciloscopio la sefial en el pin OSC2, se debe

visualizar un tren de pulsos de igual frecuencia que la del cristal utilizado.

1.2. CARACTERISTICAS DEL PIC16F84

A continuacién se explicara las principales caracteristicas del PIC16F84,

donde ayudara a comprender de mejor manera estos dispositivos.
1.2.1. CARACTERISTICAS DE LA CPU RISC

* Eljuego de instrucciones tiene 35 instrucciones de una sola palabra.
» Todas las instrucciones duran un ciclo maquina, excepto las de salto que
duran dos.

* Velocidad de operacion:

DC-20 MHz, para la frecuencia de reloj de entrada.

DC-200 ns, para la duracion del ciclo maquina.

* Frecuencia maxima de funcionamiento de 4 MHz para el PIC16F84A 6
20 MHz para el PIC16F84A.

* Memoria de programa tipo Flash de 1024 posiciones.

e Memoria RAM de datos de 68 bytes.

*  Memoria EEPROM de datos de 64 bytes.
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1.2.2.

1.2.3.

Instrucciones con una longitud de 14 bits.
Los datos tienen una longitud de 1 bytes (8bits).
Dispone de 15 registros de funcionamiento especifico.
La pila tiene 8 niveles de profundidad.
Dispone de cuatro fuentes de interrupcion, las cuales pueden ser
habilitadas o deshabilitadas independientemente por software:
1. Externa por el pin RBO/INT.
2. Por desbordamiento del timer 0.
3. Por cambio en las lineas PORTB<7:4>.
4

. Por finalizacién de escritura de la memoria EEPROM de datos.
CARATERISTICAS DE LOS PERIFERICOS.

» Dispone de 13 lineas de entrada/ salida con control individual de
direccion.
* Alta capacidad de corriente por terminal. Proporciona suficiente

corriente para gobernar un LED.

1. Consume 25 mA por pin cuando esta a nivel bajo.
2. Proporciona 20 mA por pin cuando esta a nivel alto.

» Dispone de un Temporizador/ Contador de 8 bits (TMRO) con division

de frecuencia programable.
CARACTERISTICAS ESPECIALES DEL MICROCONT ROLADOR

La memoria Flash de programa admite hasta 1.000 ciclos de borrado y
escritura.

La memoria EEPROM de datos admite hasta 1.000.000 de ciclos de
borrado y escritura.

Garantiza una retencion de datos para la memoria EEPROM de datos
superior a los 40 afos.

Se puede programar en el circulo via serie de dos pines, ICSP (In Circuit

Serial Programming)
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e Dispone de un temporizador Watchdog (WDT) con su propio oscilador
RC para un funcionamiento fiable.

* Proteccion de codigo de programa mediante la activacion de un bit de
proteccion.

e Modo de bajo consumo SLEEP.

» Tipo de oscilador seleccionable.

1.2.4. CARACTERISTICAS ELECTRICAS MAXIMAS ADMIS IBLES.

* Tension de cualquier pin respecto de Vss

(Excepto VDD, MCLR Yy RA4) -------m-mmmmmmmmm oo 0.3V a (vbD+0.3V)
* Tension en VDD respecto de VSS ---------m-mm-mmmmmmmmmmm oo -0,3a+ 7,5V
* Tension en MCLR respecto de VSS-------=---=-=--mmmmmmmmmmmmeoae -0,3 a + 14V
* Tension en RA4 respecto de VSS---------m-mm-mmmmmmmmmoem oo -0,3a+ 8,5V
* Potencia de disipacion total ----------==-==m-mmmm e 800 mw
* Maxima corriente por el pin VSS —-----mmmmmmmm oo 150 mA
» Maxima corriente por el pin VDD 100 mA
* Méaxima corriente de salida en bajo por cualquier pin I/O------------- 25 mA
* Méaxima corriente de salida en alto por cualquier pin I/OQ-------------- 20 mA

* Méaxima corriente de salida en bajo por el conjunto del Puerto A---80 mA
* Méaxima corriente de salida en alto por el conjunto del Puerto A---- 50 mA
* Méaxima corriente de salida en bajo por el conjunto del Puerto B- 150 mA

» Maxima corriente de salida en alto por el conjunto del Puerto B-- 100 mA
1.3. VENTAJAS DEL PIC16F84

Los productos que para su regulacidon incorporan un microcontrolador

disponen de las siguientes ventajas:

1.3.1 AUMENTO DE PRESTACIONES

Un mayor control sobre un determinado elemento representa una mejora

considerable en el mismo.
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1.3.2 AUMENTO DE LA FIABILIDAD

Al reemplazar el microcontrolador por un elevado numero de elementos

disminuye el riesgo de averias y se precisan menos ajustes.

1.3.3 REDUCCION DEL TAMANO EN EL PRODUCTO ACABA DO

La integracion del microcontrolador en un chip disminuye el volumen, la mano

de obra y los stocks.

1.3.4 MAYOR FLEXIBILIDAD

Las caracteristicas de control estan programadas por lo que su modificacion
s6lo necesita cambios en el programa de instrucciones.

El microcontrolador es en definitiva un circuito integrado que incluye
todos los componentes de un computador. Debido a su reducido tamafio es
posible montar el controlador en el propio dispositivo al que gobierna. En este
caso el controlador recibe el nombre de controlador empotrado (embedded

controller).

1.4 ORGANIZACION DE LA MEMORIA
141 MEMORIA DE DATOS RAM.

En esta memoria se destinan a guardar las variables y los datos que se
manejan en el programa, estos datos varian continuamente por lo que esta

memoria es de escritura y lectura su memoria es de tipo volatil.

Cuenta con dos bancos de memoria, Banco 0 y Banco 1.

Esta memoria esta dividida en dos partes:

1411 REGISTRO DE FUNCIONES ESPECIALES SFR

Son registros que cumplen un proposito especial en el control del
microcontrolador. Este registro esta agrupado entre las direcciones 00h a 0Bh
para el Banco 0 y entre las direcciones 80h hasta 8Bh para el Banco 1. Algunos
de los registros SFR se encuentran duplicados en la misma direccion en los

dos bancos, con el objetivo de simplificar su acceso.
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1.4.1.2 REGISTRO DE PROPOSITO GENERAL GPR.

Se puede usar para guardar los datos temporales del programa que
se esté ejecutando. Tiene 68 posiciones de memoria, ya que soélo son
operativas las del Banco 0, porque las del Banco 1 se mapean sobre el
Banco 0. Es decir, cuando se apunta a un registro de propdésito general del

Banco 1, realmente se accede al mismo registro del Banco 0.

Para seleccionar el banco a acceder hay que configurar el bit 5 del
registro STATUS. Con RPO = 0 se accede al Banco 0 y con RP0O = 1 se
accede al Banco 1. El Banco 0 es seleccionado automaticamente después

de un reset.

1.4.2 MEMORIA EEPROM DE DATOS.

Es una pequefia area de memoria de datos de lectura y escritura no
volatil, en el PIC16F84 dispone de una zona con 64 bytes de memoria
EEPROM para almacenar datos que no se pierdan al desconectar la

alimentacion.

Al escribir en una posicion de memoria ya ocupada, automaticamente se

borra el contenido que habia y se introduce el nuevo dato.

1.43 MEMORIA DE PROGRAMA

El microcontrolador esta disefiado para que en su memoria de programa

se almacenen todas las instrucciones del programa de control.

El programa a ejecutar siempre es el mismo, por tanto, debe estar

grabado de forma permanente.
Esta caracteristica de no volatilidad garantiza que la memoria mantenga

su contenido aun sin alimentacion, de forma que el programa no necesite

volver a ser cargado en el sistema cada vez que se utilice.
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La informaciébn contenida en esta memoria debe ser grabada

previamente mediante un equipo fisico denominado programador o grabador.

El PIC16F84A es un microcontrolador con un tipo memoria de programa
no volatil denominado ROM flash, que permite una grabaciéon muy sencilla,

rapida y comoda, lo que representa gran facilidad en el desarrollo de disefios.

Las memorias de programa del PIC16F84A tiene la capacidad de 1K

(1024 posiciones) y esta organizada en palabras de 14 bits.

Asi pues, la memoria de programa comienza en la posicibn 000h

(posicion inicial de reset) y llega hasta la 3FFh como se indica en la figura 1.3.

El PIC16F84 admite unas 1000 grabaciones, y el fabricante garantiza

gue la informacion permanezca inalterable durante varias decenas de afos.

1.44 EL CONTADOR DE PROGARAMA

Un programa estd compuesto por instrucciones que generalmente se
ejecutan de forma secuencial. En el PIC16F84A cada una de estas

instrucciones ocupa una posicién de memoria y programa.

El contador de programa PC es un registro interno que se utiliza para
direccional las instrucciones del programa de control que estan almacenadas

en la memoria de programa como se observa en la figura 1.3.

El registro contiene la direccion de la aproxima instruccion y se
incrementa automaticamente de manera que la secuencia natural de ejecucién

de programa es lineal.
El microcontrolador PIC16F84A dispone de un contador de programa

que le permite direccional los 1K x 14 bits de memoria de programa

implementada, desde la posiciébn 000h hasta la 3FFh.
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Figura 1.3 Arquitectura interna del PIC16F84

1.45 REGISTRO DEL SFR

En la tabla 1.1.Se detallan los registros de funciones especiales SFR
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Tabla 1.1 Registro del SFR

Direccion| Nombre | bit7 | bit6 | bit5 | bit4 | bit3 | bit2 | bitl | bit0

BANCO 0

00h |INDF Registro utilizado en el direccionamiento indirecto (no es un registro fisico)

0l1h |TMRO Timer / Contador de 8 bit

02h |PCL Registro con los 8 bit mas bajos del Contador del Programa

03h |[staTUS]| IRP | RPL | RPO | /MO | D | Z | DC | C

04h |FSR Registro utlizado como puntero en el direccionamiento indirecto

05h |PORTA RA4/TOCKI[ RA3 RA2 RA1 RAOQ

06h [PORTB RB7 RB6 RB5 RB4 RB3 RB2 RB1 RBO/INT

07h Posicion no implementada, se lee como 0

08h |EEDATA | Registros de datos EEPROM

09h |EEADR |Registro de direcciones EEPROM

0Ah |PCLATH Buffer escrito con los 5 bit mas altos del PC

0Bh |INTCON | GIE EEIE TOIE INTE [ RBIE | TOIF [ INTF | RBIF
BANCO 1

80h |INDF Registro utilizado en el direccionamiento indirecto (no es un registro fisico)

81h |OPTION | /RBPU [INTEDG|] T0SC | TOSE | PSA | Ps2 Ps1 | Pso

82h |PCL Registro con los 8 bit mas bajos del Contador del Programa

83h |[stAaTUsS| IRP | RPL | RPO | MmO | D | Z | DC | C

84h |FSR Registro utlizado como puntero en el direccionamiento indirecto

85h [TRISA [ [ [Reg. De configuracion de las lineas del Puerto a

86h |TRISB Registro de configuracion de las lineas del Puerto B

87h Posicion no implementada, se lee como 0

88h |EECON1 [ | | EEIF |WRERR| WREN | WR | RD

89h |EECONZ2 |Reg. De control para grabar en la EEPROM de datos (no es un registro fisico)

8Ah |PCLATH Buffer escrito con los 5 bit mas altos del PC

8Bh |INTCON | GIE | EEIE | TOIE | INTE [ RBIE | TOIF [ INTF | RBIF
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1.45.1 INDF

Registro para el direccionamiento indirecto de datos. Este no es un
registro disponible fisicamente. Utiliza el contenido del SFR para seleccionar
indirectamente la memoria de datos o RAM del usuario; la instruccidon

determinara lo que se debe hacer con el registro sefialado.

El direccionamiento indirecto es un recurso de los microcontroladores
PIC16F84A.

Para el direccionamiento indirecto se utiliza los registros INDF y FSR
ubicados dentro de la zona de registros especiales, concretamente en la
posiciéon 00h y 04h del Banco 0, aunque el registro INDF no esta implementado

fisicamente.
El registro FSR sirve como puntero para el direccionamiento indirecto.
Si en cualquier instruccién se opera con el registro INDF, en realidad se esta

operando con la direccion donde se apunte el contenido del registro FSR.

Por ejemplo si el FSR contiene el valor 14h una instruccion que opera
sobre INDF, opera en realidad sobre la direccién 14h.

Se puede decir en este ejemplo que la posicion 14h de memoria fue

direccionada en forma indirecta a través del puntero FSR.
Si FSR =14h, la instruccion movwf INDF carga el contenido de registro
W en la posicion 14h de la RAM, tal como se muestra en la figura 1.4.

Simbdlicamente se representa:

(W) = ((FSR)), en este ejemplo, (W) > (14h)

20



Memoria RAM

W de Datos
ik :~: —
[

-‘H"t
FSE 14w [ 28k

14k :~: —_—

A) Al ejecutar movwf INDF

Figura 1.4. Funcionamiento de las instrucciones de Direccionamiento Indirecto

Siguiendo con otro ejemplo, si FSR=14h, la instruccion movf INDF,W
carga el contenido de la posicion 14h de la RAM en el registro de trabajo W, tal

como se muestra en la figura 1.5. Simbdlicamente se representa:

((FSR)) — (W), en este ejemplo, (14h)—/ (W)

W Memoria RAM
De Datos
B2h
'\\
ESR / 14h B2h
14h 1

B) Al ejecutar movf INDF,W

Figura 1.5 . Funcionamiento de las instrucciones de Direccionamiento Indirecto

El direccionamiento indirecto es muy Uutil para el procedimiento de

posiciones consecutivas de memoria RAM de datos.
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1.45.2 TMRO (timer 0).

Temporizador/contador de 8 bits. Se incrementa con una sefial externa
aplicada al pin RA4/TOCKI o de acuerdo a una sefal interna proveniente del

reloj del microcontrolador.

El PIC16F84A dispone de un timer principal denominado Timer O o
TMRO que es un contador ascendente de 8 bits. EI TMRO se inicializa con un
valor, que se incrementa con cada impulso de entrada hasta su valor maximo
b”11111111” ; con el siguiente impulso de entrada el contador desborda
pasando a valer b”00000000", circunstancias que se advierte mediante la

activacion del flag del contaje localizado en el registro INTCON.

Cuando el TMRO trabaja como temporizador cuenta los impulsos de
fosc/4. Se usa para determinar intervalos de tiempo concreto. Estos impulsos
tienen una duracién conocida de un ciclo maquina que es en cuatro veces el

periodo de la sefal de reloj.

Para una frecuencia de reloj igual a 4MHz el TMRO se incrementa cada

1 ps.

Como se trata de un contador ascendente el TMRO debe ser cargada
con el valor de los impulsos que se desean contar restados de 256 que es el
valor de desbordamiento, por ejemplo para contar cuatro impulsos se carga al
TMRO con 256 — 4 = 252.

Numero de pulsos a contar: 410 =b"00000100”

Numero a cargar: 25610 = 25210 = b”11111100”

Incrementar a cada ciclo de instruccion: b”11111100” , b"11111101” ,
b”11111110” , b"11111111” ; aqui se desborda pasando a b”0000000” y

activando al flan TOIF.

De esta manera, con la llegada de cuatro impulsos, el timer se ha
desbordado alcanzando el valor b”00000000” que determina el tiempo de
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temporizacion, en este caso 4 ps si los impulsos se hubieran aplicado cada

microsegundo.

1.45.3 PCL (Program Counter Low byte).

Byte bajo del contador de programa, figura 1.6, el PIC16F84A dispone
de un contador de programa de 13 bits. Sus bits de menor peso corresponden
a los 8 bits del registro PCL , implementado en la posicion de memoria
RAMO2h y duplicada en la posicion 82h del bancol por lo que puede ser leido

0 escrito directamente.

PCH PCL

12 11 10 8 7
N N D B

A
2 % PCLATH <4:3> 11
| /

Opcode<10:0

PCLATH

Figura 1.6 Composicion del PC en instrucciones “call” y “goto”

Los cinco bits de mayor peso del PC corresponden con los del registro

PCH que no puede ser leido ni escrito directamente figura 1.7.

Al conectar la alimentaciébn se inicializa a (PCL)=b"00000000" y
(PCH)=b"00000"
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PCH PCL

12 8 7 0
[TT1 [TTT1
A A
5 PCLATH<4:05 8 ALU
- : Resultado
BN PCLATH

Figura 1.7. Composicion del PC en instrucciones con PCL como destinatario

1454 STATUS

El registro de estado o STATUS indicada el estado de la ultima
operacion aritmética o logica realizada, la causa de reset y los bits de seleccion

de banco para la memoria de datos.

A los bits de registro de estado se les suele denominar flags. Al conectar

la alimentacion los contenidos es (STATUS)=b"00011xxx".

Tabla 1.2 Registro de estado o STATUS

IRP RP1 RPO ITO /PD Y4 DC C
Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

14541 C (Carry bit).

Flag de acarreo en el octavo bit. Esta instruccion de suma aritmética se
activa cuando se presenta acarreo desde el bit mas significativo de resultado,
lo que indica que el resultado ha desbordado la capacidad del registro sobre el
que trabaja, es decir, el resultado de la operaciéon ha superado el valor
111111112, (25510), que es el maximo valor que se puede representar con 8
bits.
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C=0. En la suma significa que no habido acarreo y en la resta que el

resultado ha sido negativo.

C=1. En la suma significa que habido acarreo y en la resta que el

resultado a sido positivo.

1.4.5.4.2 DC (Digital carry).

Flag de acarreo en el cuarto bit de menos peso. En operaciones
aritméticas se activa cuando hay un acarreo entre el bit 3 y 4, es decir, cuando

hay acarreo entre los nibbles (medios bytes) de menor y mayor peso.

1.45.4.3 Z (Zero).

Flag de cero. Se activa a “1” cuando el resultado de una operacion

aritmética o logica es cero.

Z=0. El resultado de la ultima operacién ha sido distinto de cero.

Z=1. El resultado de la ultima operacién ha sido cero.

1.45.4.4 /PD (Power Down).

Flag de bajo consumo. Es un bit sélo de lectura, no puede ser escrito
por el usuario. Sirve para detectar el modo de bajo consumo.

/PD=0. Al ejecutar la instruccion sleep y entra en reposo.

/PD=1. Tras conectar la alimentacién Vb o al ejecutar clrwdt.

1.45.45 /TO (Timer Out).

Flag indicador de fin de temporizacién del Watchdog. Es un bit de sélo
lectura, no puede ser escrito por el usuario. Se activa en “0” cuando el circuito
de vigilancia Watchdog finaliza la temporizacién. Sirve para detectar si una
condicion de reset fue producida por el Watchdog Timer.
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/ITO=0. Al desbordar el temporizador del Watchdog Timer.

/ITO=1. Tras conectar VDD (funcionamiento normal) o al ejecutar las

instrucciones clrwdt o sleep.

1.45.4.6 RPO (Register Bank Select bit).

Seleccién del banco para el direccionamiento directo. Sefiala el banco
de memoria de datos seleccionado.
RPO=0. Selecciona el Banco 0.

RPO=1. Selecciona el Banco 1.

1455 FSR

Selector de registro para direccionamiento indirecto. En asociacion con
el registro INDF se utiliza para seleccionar indirectamente los otros registros

disponibles.

Al conectar su alimentacibn su contenido es desconocido,

(FSR)=b"XXXXXXXX".

1.45.6 PORTA

Puerto de entrada/salida de 5 bits (pines RBO a RB4). El puerto A puede

leerse o escribirse como si se tratara de un registro cualquiera.

El registro que controla el sentido (entrada/salida) de sus pines se llama
TRISA vy esta localizada en la direccion 85h del Bancol. Su pin RA4/TOCKI
también puede servir de entrada al Timer 0. Al conectar la alimentaciéon queda

configurada como entrada.

1.45.7 PORTB

Puerto de entrada/salida de 8 bits . El puerto B puede leerse o escribirse
como si se tratara de un registro cualquiera. El registro que controla el sentido
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(entrada/salida) de sus pines se llama TRISB y esta localizada en la direccion
86h del Banco 1. Alguno de sus pines tiene funcion alterna en la generacion de

interrupcién. Al conectar la alimentacion queda configurada como entrada.

1.45.8 EEDATA (EEPROM Data register).

Contiene los bytes que se van a escribir o que se han leido de la
EEPROM de datos. Al conectar la alimentacion su contenido es desconocido,
(EEDATA)=b"XxxxxxxX"

1.45.9 EEADR (EEPROM Address Register).

Contiene la direccion de la EEPROM de datos a la que accede para leer
o escribir. Al conectar la alimentacion su contenido es desconocido,
(EEADR)=b"XxXxXXXXX".

1.45.10  PCLATH (PC Latch Hight).

Registro que permite acceder de forma indirecta a la parte alta del
contador de programa en alguna instruccién. Al conectar la alimentacion se
resetea (PCLATH)=b"---00000".

14511 INTCON (Interrupts Control Register).

Registro para el control de las interrupciones. Es el encargado del
manejo de las interrupciones. Contiene los 8 bits que se muestra en la tabla 1.3
, de los cuales unos actian como flags sefaladotes del estado de la
interrupcion y otro como bits de permiso o autorizacion para que se pueda
producir la interrupcion. Al conectar la alimentacion su contenido es
(INTCON)=b"0000000x".

Tabla 1.3 Registro de control de las interrupciones INTCON

GIE EEIE | TOIE INTE RBIE TOIF INTF RBIF
Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
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145111 RBIF (RB port change Interrupt Flag).

Flag de estado de interrupciéon RBI.

Indica que se ha producido una interrupcion por cambio de estado de

cualquiera de las lineas RB4 a RBY.

RBIF=0. Ninguna de las entradas RB7 a RB4 ha cambiado de estado.

RBIF=0. Cualquiera de las lineas RB7a RB4 del puerto B ha cambiado.

1.45.11.2 INTF (External Interrupt Flag bit).

Flag de estado de la interrupcién externa INT. Indica que ha ocurrido una

interrupcion a través del pin RBO/INT. (Debe borrarse por software).

1.45.11.3 TOIF (TMRO Overflow Interrupt Flat Bit).

Flat de estado de la interrupcién producida por un TMRO. Indica que se
producido una interrupcion por desbordamiento del Timer O, es decir, que a
pasado de b"11111111” (FFh) a b"00000000” (00h).

TOIF=0. El TMRO no se ha desbordado.

TOIF=1. El TMRO se ha desbordado. (Debe borrarse por software).

145114 RBIE (RB Port Change Interrupt Enable).

Habilitacion de la interrupcion RBI. Flag que autoriza la interrupcion por
cambio de estado de las lineas RB7:RB4 del puerto B.
RBIE=0. Interrupcion RBI deshabilitada.

RBIE=1. Interrupcion RBI habilitada.

28



1.45.11.5 INTE (External INT Enable bit).

Habilitacion de la interrupcion externa INT. Flag que autoriza la

interrupcion externa a traves del pin RBO/INT.

INTE=0. Interrupcion INT deshabilitada.

INTE=1. Interrupcion INT habilitada.

1.45.11.6 TOIE (TMRO Interrupt Enable bit).

Habilitacion de la interrupcion TOI. Flag que autoriza la interrupcion por

desbordamiento del Timer O.

TOIE=0. Interrupcion TOI deshabilitada.

TOIE=1. Interrupcién TOI habilitada.

1.45.11.7 EEIE (EEPROM Write Complete Interrupt Enable).

Habilitacion de la interrupcion EEI. Flag que autoriza la interrupciéon por
escritura completa de un byte en la EEPROM de datos del PIC (el flag EEIF se

encuentra en el registro EECONL).

EEIE=0. Interrupcion EEI deshabilitada.

EEIE=1. Interrupcién EEI habilitada.

1.45.11.8 GIE (Global Interrupt Enable).

Flag de habilitacion global del permiso de interrupcion. Se borra
automaticamente cuando se reconoce una interrupcion para evitar que se
produzca otra mientras se esta atendiendo a la primera. Al retorno de la
interrupcion con una instruccion retfie, el bit GIE se vuelve a activar poniéndose

a “1”_
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GIE=0. No autoriza interrupcion de ningun tipo.

GIE=1. Autoriza cualquier tipo de interrupcion. Se pone a “1”

automaticamente con la instruccion retfie.

1.45.12 OPTION

Registro de configuracion multiple, aunque su mision principal es
gobernar el comportamiento del TMRO. Algunos microcontroladores PIC tienen
una instruccion denominada también option, por ello, el fabricante Microchip
recomienda darle otro nombre a este registro. Asi en el fichero de definicion de
etiqueta P16F84.

INC se le nombra como OPTION_REG. Al conectar la alimentacion
todos sus bits se pone a “1”, OPTION_REG ="b11111111".

Tabla 1.4. Registro OPTION_REG

/RBPU [INTEDG | TOCS | TOSE PSA pPS2 PS1 PSO
Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O

145121 PS2:PS0O

(Prescaler Rate Select bits). Bits para seleccionar los valores del
Prescaler o rango con el que actua el divisor de frecuencia, segun la tabla 1.5.
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Tabla 1.5 Seleccion del rango del divisor de frecuencia

PS2 PS1 PSO Divisor del TMRO Divisor del WDT
000 1:2 11
001 1:4 1:2
010 1:8 1:4
011 1:16 1:8
100 1:32 1:16
101 1:64 1:32
110 1:128 1:64
111 1:256 1:128

1.45.12.1 PSA (Prescaler Assignment bit).

Asignacion del divisor de frecuencia. El Prescaler es compartido entre el
TMRO y el WDT,; su asignacion es mutuamente excluyente ya que solamente a
uno de ellos se puede aplicar el divisor de frecuencia a la vez.

PSA=0. El divisor de la frecuencia se asigna al TMRO.

PSA=1. El divisor de la frecuencia se asigna al Watchdog.

1.45.12.2 TOSE (TMRO Source Edge Select bit).

Selecciona flanco de la sefial al TMRO.

TOSE=0. TMRO se incrementa en cada flanco ascendente de la sefal
aplicada al pin RA4/TOCKI.

TOSE=1. TMRO se incrementa en cada flanco descendente de la sefial
aplicada al pin RA4/TOCKI.

31



1.45.12.4 TOCS (TMRO Clock Source Select bit).

Selecciona la fuente de la sefial TMRO.

TOCS=0. Pulso de reloj interno Fosc/4 (TMRO como temporizador).

TOCS=1. Pulsos introducidos a través del pin RA4/TOCKI (TMRO como

contador).

1.45.12.5 INTEDG (Interrupt Edge Select bit).

Selector de flanco de la interrupcion INT.

INTEDG=0. Interrupcion por flanco descendente del pin RBO/INT.

INTEDG=L1. Interrupcién por flanco ascendente del pin RBO/INT.

1.45.12.6 /RBPU (Resistor Port B Pull-Up Enable bit).

Habilitacion de las resistencias de Pull-Up del Puerto B.

/RBPU=0. Habilita las resistencias del Pull-Up del puerto B.

/RBPU=1. Deshabilita las resistencias del Pull-Up del puerto B.

1.45.13 TRISA

Registro de configuracion de las lineas del Puerto A. Es el registro de

control para el Puerto A.

Un “0” en el bit correspondiente al pin lo configura como salida, mientras
que un “1” lo hace como entrada. Al igual que el puerto A, solo dispone de 5
bits. Al conectar la alimentacion todos sus bits se ponen a “1” ,
(TRISA) = b"---11111".
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1.45.14 TRISB

Registro de configuracién de las lineas del puerto B. Es el registro de

control para el puerto A.

Un “0” en el bit correspondiente al pin lo configura como salida, mientras
que un “1” lo hace como entrada. Al conectar la alimentacion todos sus bits se
pone a “1”, (TRISB) = b”11111111".

1.4.5.15 EECON1 (EEPROM Control Register 1).

Registro para el control de la memoria EEPROM de datos. Al conectar la
alimentacion su contenido (EECONL1) = b”"0x000".

Tabla 1.6 Registro de control de la EEPROM de datos INTCON

EEIF |WRERR| WREN | WR RD
Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O

145141 RD (Read Control Bit).

Bit de control de lectura en la EEPROM. Al ponerlo en “1” se inicia la
lectura de un byte en la EEPROM de datos. Este bit se limpia (se pone a “0”)
por hardware autométicamente al finalizar la lectura de la posicion EEPROM.

RD=0. No inicializa la lectura de la EEPROM o la misma ha terminado.

RD=1. Inicializa la lectura de la EEPROM. Se borra por hardware.

1.45.14.2 WR (Write Control Bit).

Bit de control de escritura en la EEPROM. Al ponerlo en “1” se inicia una
escritura de un byte en la EEPROM . Este bit se limpia (se pone en “0") por

hardware automaticamente una vez la escritura de la EEPROM ha terminado.
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WR=0. No inicia la escritura de la EEPROM o la misma ha terminado.

WR=1. Inicia la escritura de la EEPROM. Se borra por hardware.

1.45.14.3 WRERR (EEPROM Write Error Flag Bit).

Flag de error en la escritura. Se posiciona a “1” cuando la operacion de

escritura termina prematuramente debido a cualquier condicidon de reset.

WRERR=0. La operacion de escritura se ha completado correctamente.

WRERR=1. La operacion de escritura ha terminado prematuramente.

1.4.5.14.4 EEIF (EEPROM Write Operation Interrupt Flag Bit).

Flag de estado de la operacién de escritura de un byte en la EEPROM.

EEIF=0. La operacion de escritura de la EEPROM no ha terminado o no

comenzo.

EEIF=1. La operacion de escritura de la EEPROM ha terminado. Debe

borrarse por software.

1.45.14.5 Bits 5,6 y 7 (Unimplemented).

No implementados fisicamente. Se leen “0".
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1.45.15 EECON2 (EEPROM Control Register 2).

Este registro no esta implementado fisicamente, por lo que es imposible
leerlo (si se intenta leer, todos sus bits se leen como cero). Se emplea como
dispositivo de seguridad durante el proceso de escritura de la EEPROM, para
evitar las interferencias en el largo intervalo de tiempo que precisa su

desarrollo.

1.45.16 REGISTROS DE CONFIGURACION

El PIC16F84 dispone de una palabra de configuracion de 14 bits que se
escribe durante el proceso de grabacién del microcontrolador y que no se
puede modificar durante la ejecucion de un programa.

Dicho bits ocupan la posicidén reservada de memoria de programa 2007h

Tabla 1.7 Registro de configuracién (Configuraciéon Word)

CP |PWRTE| WDTE | FOSC1 | FOSCO
Bit13 | ...... Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

1.45.16.1 FOSC<1:.0>

(Flag Oscilador Selection). Seleccién del tipo de oscilador:

FOSC = 00. Oscilador de bajo consumo LP (32KHz - 200KHz)

FOSC = 01. Oscilador estandar XT (100KHz — 4MHz)

FOSC =10. Oscilador de alta velocidad HS (4MHz — 20MH2z)

FOSC = 11. Oscilador de bajo corte RC.

1.45.16.2 WDTE (Watchdog Enable).

Bit de habilitacion del Watchdog.
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WDTE = 0. Watchdog deshabilitado.

WDTE = 1. Watchdog habilitado.

1.4.5.16.3 PWRTE (Power-up Timer Enable).

Activacion del temporizador Power-up.

PWRTE = 0. Temporizador Power-up deshabilitado.

PWRTE = 1. Temporizador Power-up habilitado.

1.45.16.4 CP (Code Protection bit).

Bit de proteccion de cédigo.

CP = 0. Toda la memoria de programa esta protegida contra lecturas
indeseables.

CP = 1. La memoria de programa se puede leer. No esta protegida.

1.5 SUBRUTINAS

Las subrutinas son técnicas para realizar codigos de programa mas cortos y

eficaces.

1.5.1 DETALLE DE LAS SUBRUTINAS

Algunas veces el mismo grupo de instrucciones es ejecutado en
diferentes partes de un programa. Segun el procedimiento planteado hasta el
presente, cada vez que dicho tramo de programa es requerido debera insertar
dentro del programa principal tantas veces como esto sea necesario. Esta

puede parecer la forma mas directa de atacar el problema pero es ineficiente
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ya que requiere mayor extension del programa y por lo consiguiente mayor

utilizacién de la memoria ROM.

El flujo de programa resulta secuencial tal como se muestra en la figura
1.8.

ProcesoX
call ProcesoX
ProcesoX return
call ProcesoX

SUBRUTINA

call ProcesoX

ProcesoX
PROGRAMA PRINCIPAL
ProcesoX i )
Sin Subrutina
La utilizacion de subrutinas evita la
PROGRAMA PRINCIPAL repeticion de bloques de instrucciones

Sin Subrutina

Figura 1.8 Utilizacion de las subrutinas

La solucién mas efectiva en términos de ahorro de memoria, se obtiene
si el grupo de instrucciones que se repita aparezca una sola vez en el
programa, pero con capacidad para ser ejecutado desde todos los puntos en el

que aquel se pida, para implementar esta solucion se utiliza la subrutina.
Una subrutina es un conjunto de instrucciones al que se tiene acceso
desde cualquier punto del programa principal. Es decir, es un subprograma que

se ejecuta cada vez que el programa principal lo necesita.

Como una subrutina conceptualmente queda fuera del flujo secuencial

del programa principal, son necesarios ciertos mecanismos para poder llegar a
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ella, una vez que se ha ejecutado las instrucciones que la componen, debe ser
posible regresar al punto donde se quedd la ejecucion del programa.

La accion de pasar del programa principal a la subrutina se denomina
“llamar al subrutina” y se realiza con la instruccion call. Que se debe intercalar

en el programa principal, como se muestra en la figura 1.8.

La accién de volver al programa principal después de llevar a cabo las
tareas determinadas por la subrutina se llama “retorno de la subrutina” y se
realiza con la instruccién return es un “salto inteligente” que sabe que tiene que
volver a la instruccion inmediatamente después del call que llamé a la

subrutina.

La figura 1.8 ilustra el procedimiento de ejecucion del programa con

subrutinas.

La instruccion del programa principal son ejecutadas sucesivamente
hasta que se encuentra la primera instruccion call procesos, después de lo
cual, la subrutina ProcesosX se ejecuta como cualquier otra seccion del
programa. La ultima instruccion de la subrutina es return que causa el regreso

de la secuencia de ejecucion al programa principal.

El programa con subrutina de la figura 1.8 podria tener el siguiente
formato:

Principal ; Comienzo del programa principal.

call ProcesoX ; El control del programa pasa a la subrutina
; “Procesos”. Después de ejecutar la
; la subrutina la ejecucion del programa
; vuelve a la instruccion después del “call”

call ProcesoX ; El control del programa pasa a la subrutina

; “Procesos”. Después de ejecutar la

; la subrutina la ejecucién del programa
; vuelve a la instruccion después del “call”
;SUDrUtinga “ProCeS0 X -==--mmm e m oo

Procesos

;Aqui la instruccion de la subrutina.
Return :La subrutina devuelve con “return” el
;control al programa inicial.

END ;directiva “END” al final del programa.
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La principal ventaja de las subrutinas es que la extension de los

programas se hace mucho mas corta. No obstante las subrutinas presentan

una desventaja, provoca una ejecucion mas lenta debido a que se tiene que

ejecutar dos instrucciones extras call y return cada vez que se realiza una

llamada y el obligado retorno de subrutina.

1.5.2 SUBRUTINAS ANIDADAS

Cuando una subrutina llama a otra subrutina se produce la situacion

conocida como anidamiento de subrutinas,

dentro de oftra.

es decir, hay subrutinas anidadas

Cada call sucesivo sin que intervenga un return crea un nivel de

anidamiento adicional. Esto se ilustra en la figura 1.9.

Programa
Principal

—— call Procesol
X1

PILA

SUBRUTINA 1

Procesol

call Proceso?2

return

X2

_ N

SUBRUTINA 2

Proceso 2

return

— call Proceso2

X3

SUBRUTINA 3

Proceso 3

call Proceso?2

return

Estructura de subrutinas anidadas a tres niveles

X1

PILA

X2

X1

PILA

Figura 1.9 Subrutinas anidadas
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La figura 1.9 puede tener el siguiente formato:

Principal ; Comienzo del programa principal

Procesol ; El control del programa pasa a la subrutina “Procesol”
; Después de ejecutar la subrutina “Procesol” la
; ejecucion del programa vuelve a la instruccion
; inmediata después de “call”.
; Aqui la instruccion final del programa principal.

call

: Subrutina “Procesol”

Procesol
; Aqui las instrucciones de la subrutina “Procesol”.

; El control del programa pasa a la subrutina “Proceso2”
; Después de ejecutar la subrutina “Proceso2” la

; la ejecucién del programa vuelve a la instruccion

; inmediata después del call.

call Proceso?2

return ; Esta subrutina devuelve el control al programa principal

: Subrutina “Proceso?2”

Proceso2
; Aqui las instrucciones de la subrutina “Proceso2”.

; El control del programa pasa a la subrutina “Proceso3
; Después de ejecutar la subrutina “Proceso3” la

; la ejecucién del programa vuelve a la instruccion

; inmediata después del call.

call Proceso2

return

: Subrutina “Proceso3”

Proceso3
; Aqui las instrucciones de la subrutina “Proceso3”.
return
END ; La directiva “END” se pondra al final del programa.

El nivel de anidamiento esta limitado para cada microcontrolador y en el
microcontrolador PIC16F84 es de 8 niveles. Es decir, para un PIC16F84 no
puede haber més de ocho subrutinas anidadas como las esquematizadas en la

figura 1.9.
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153 LAPILA

La pila es una zona de memoria que se encuentra separada tanto de la

memoria de programa como de la de datos dentro del microcontrolador.

Su estructura es de tipo LIFO (Last In First Out) por lo que el dltimo dato

gue se guarda es el primero que sale.

El PIC16F84 dispone de una pila con ocho niveles o registros de una

longitud de 13 bits cada uno de ellos como se lo puede interpretar en la figura

1.10.

CONTADOR DE
PROGRAMA

PC<12:0>

13
7'y
call, return, retfie, retlw
A
7'y ) .
Nivel 1 de Pila
I
PILA |
I
Nivel 8 de Pila
v
* Vector de Reset 000h
I
I
MEMORIA DE Vector de Reset 0004h
PROGRAMA
Y T —w=7==m3 O03FFh
d'lhf"‘ |4-‘-.|::? _.::-.-.._-_.- MLJ;EI "‘:.
|-l 'i ‘-\. -\h
& *I\Ibf Qg\plélﬁenﬁdo. 1
” "" T i [Fa ...;'.'_.j"'.‘;-:- 1FFFh

Figura 1.10 Estructura de la pila y memoria de programa del PIC16F84
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La manera de cargar la pila es a través de la llamada a subrutina con la
instruccion call , que almacena el contenido del contador de programa (PC) en
la posicion superior de la pila. Para recuperar el contenido de la pila en el PC,

hay que ejecutar la instruccion de retorno de subrutina return.

1.5.4 INSTRUCCIONES “CALL" Y “RETURN”

La localizacion de una subrutina se identifica por la direccion de su

primera instruccion.

El efecto de la instruccion call es provocar que la que la ejecucién se
transfiera a la subrutina. De esto se desprende que la mencionada instruccion
contenga la direccion de la primera posicibn de memoria ocupada por la

subrutina, como se lo detalla en la figura 10.11.
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0A6 call Proceso MEMORIA DE
NA7 PROGRAMA
1B5 Proceso .......
1C3 return
PC PC PC PC
0AG6 1B5 XXX 1C3
PILA PILA PILA PILA
0A7 0A7 0A7
Antes del Al ejecutar Durante la Antes del
“call “call subr. “return”
Proceso” Proceso” “Proceso”

PC

0A7

PILA

0A7

Al ejecutar
“return”

Figura 1.11 Mecanismo de funcionamiento de una subrutina.

Por otro lado, la instruccion return que provoca el retorno al programa

principal, debe “recordar” la localizacion de la instruccion que sigue al call. Esto

es posible solo si la direccion de esa instruccion ha sido preservada en una

zona de memoria, que no es otra que la pila.

Antes de transferir el control a una subrutina, la instruccién call se

encarga de almacenar en la pila la direccion de la instruccion que sigue. Esto

es asi porque el contador de programa se incremente automaticamente cada

vez que el microprocesador ejecuta una instrucciéon el PC ya se encuentra

apuntando a la direccion de la siguiente instruccion.
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Por lo tanto, cuando la instruccion call deposita en la pila el contenido del
PC, lo que efectivamente esta preservando es la direccion del punto de retorno.
La figura 1.11 ilustra este mecanismo.

La transferencia de la secuencia de ejecucion a la subrutina se logra
cargando el PC con la direccion contenida en la instruccion call . De esta forma,

la siguiente instruccidn que se obtiene de la memoria proviene de la subrutina.

La ejecucion de la instruccion return extrae la direccion almacenada en
la pila y la transfiere al PC. Asi, la proxima instruccién que se ejecuta después
del return es precisamente la siguiente al call (que es la que se habia

guardado previamente en la pila), regresando el control al programa principal.

En las subrutinas anidadas, el efecto de cada instruccion call es guardar
en la pila la direccion apropiada para el retorno. La instruccion return y sus
efectos en la pila aseguran que el control del programa eventualmente regresa

a la instruccién siguiente al primer call, como se observa en la figura 1.9.

El nUmero de subrutinas anidadas esta limitado por el tamafio de la pila
de cada microcontrolador. En el PIC16F84 la pila tiene un tamafio de 8
posiciones, por lo tanto el anidamiento maximo de 8 niveles. No hay ningun
mecanismo hardware que indique desbordamiento de la pila, debe ser el
disefiador del programa quien debe procurar que esto no se produzca.

1.5.5 VENTAJAS DE LAS SUBRUTINAS

* Se puede escribir como subrutinas secciones de cédigo y ser empleadas
en muchos programas.

» Dan a los programas un caracter modular. Se puede codificar diferentes
modulos para usarlos en cualquier programa obteniendo asi una libreria de
subrutinas.

 Reduce notablemente el tiempo de programacion y la deteccién de

errores.
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» El cddigo es mas facil de interpretar, dado que las instrucciones de las
subrutinas no aparecen en el programa principal. Sélo figuran las llamadas

call.

1.5.6 LIBRERIA DE SUBRUTINAS

Es frecuente necesitar mas de una subrutina en los programas. También
es habitual que algunas subrutinas se utilicen en varios programas. En estos
casos es conveniente disponer de bibliotecas de subrutinas denominadas

librerias.

En cada programa se cargan las subrutinas que se precisen. El
ensamblador MPASM dispone de una directiva denominada INCLUDE que
realiza esta funcion “pegando” el fichero de referencia en el programa. dicho

fichero se inserta en el cédigo durante el proceso de ensamblado.

1.5.7 DIRECTIVA“INCLUDE”
El formato de la directiva INCLUDE es:
INCLUDE <include_file>
El fichero especificado por <include_file> es leido como un fichero
fuente. El efecto es el mismo que si el texto entero del <include_file> hubiera
sido insertado dentro del fichero origen en la localizacion donde esta directiva

se encuentra.

Es importante tener en cuenta que este fichero <include_file> no debe

finalizar con la directiva END, la cual debe ir situada en el programa principal.

Esta directiva se usa cuando se incluye al principio de los programas

INCLUDE <P16F84A.INC
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Con la directiva anterior lo que se hace es afiadir al programa la

definicion de los registros de SFR y de sus bits.

Si es especificada la trayectoria completa del fichero <include_file>, solo
en ese trayecto sera buscado. En caso contrario el orden de busqueda seré:
directorio actual de trabajo, directorio del fichero fuente y, por ultimo, directorio
del fichero ejecutable MPASM.EXE.

La extension “*.INC” no es obligatorio, aunque se recomienda su
utilizaciébn para diferenciarlos de los programas propiamente dichos con

extensién “*.asm”.

Los ficheros include a su vez pueden tener otras directivas INCLUDE,
pero no es recomendable ya que puede provocar confusion. De todas formas
este anidamiento tampoco es ilimitado, puesto que el MPASM sélo permite

hasta seis niveles.

1.5.8 SIMULACION DE SUBRUTINAS EN MPLAB

En el simulador del MPLAB, con el comando Debugger > Step Into se
ejecutarian paso a paso todas y cada una de las instrucciones que conforman

la subrutina.

» PIEBNDEVHOE [C e e iis s Saiiings = puiis docnpiapios s il j jﬂl

] Fle Edit Wiew Project Programmet Configure  Window  Help - 8 x
~ Select Tool »
O & N W
Clear Memory ¥ @

l ;************** i |:|3_asm*************************** —
o 3 Run Fa — -
2 ; Por el pusrto Animate itto de las cinco lineas del Puesrto A al

que este conect
4 ; un array de i Step Into F7 ijemplao, =i por el Puerto A =e

introduce "---1
= ;2l Puesrto B ap Step Cuk iel walor de las tres lineas superiores =—

Figura 1.12 Las subrutinas se pueden ejecutar con el comando Step Over
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Sin embargo, a veces en la simulacion interesa ejecutar la subrutina sin
tener que ejecutar una por una todas sus instrucciones. Para esto se utiliza el
comando Debugger > Step Into, pero cuando llega a la ejecucion de una
subrutina (instruccion call) ésta se ejecuta de igual forma que si fuera una sola

instruccion.

El contenido de la pila puede visualizarse seleccionado la opcion View >

Hardware Snack, como se alustra en la figura 1.13.

' INPIRBNDEV G0 = (=] E3]
File Edit Project Debugger Programmer Configure  Window  Help
=~ Project 4 "
0O = o @ I pouler M PR
Oukpuk
] Disassembly Listing (W aTE ST ‘__J ‘__J k.a
iy ; ] |Stack Level| Feturn Address| Location
o A Pragram Memory
A .| File Registers > o Empty
A .| EEPROM 1 0ooo
- 3 oooo
3 ; ‘akch
P o5 o | Function Regist 4 i B
g pecial Function Regiskers c 0ooo
7 ; Simulator Trace = oooo
o rI
= CONF [.I

Figura 1.13 Visualizacion de la pila en el MPLAB

1.6 SUBRUTINA DE RETARDO

Controla el tiempo que tarda en ejecutarse algunas acciones.

1.6.1 CICLO MAQUINA

El tiempo que tarda en ejecutar un programa depende de la frecuencia
del oscilador conectado al microcontrolador y del nimero de ciclo maquina

ejecutados.

Se lo define como un ciclo maquina como la unidad basica de tiempo

que utiliza el microcontrolador. Para el PIC16F84 el ciclo maquina equivale a 4
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ciclos de reloj, por lo tanto, el tiempo que tarda en producirse un ciclo maquina
es igual a cuatro veces el periodo del oscilador, como se lo puede observar en

la figura 1.14.

4 Ciclo de reloj

A 4

< CICLO MAQUINA

1 CICLO MAQUINA = 4 CICLOS DE RELOJ

Figura 1.14 Ciclo maquina para el PIC16F84

Las instrucciones en el microcontrolador PIC16F84 necesitan 1 ciclo
maquina para ejecutarse, excepto las de salto (goto, call, btfsc, return, etc) que

necesitan de dos ciclos maquina.

El tiempo que tarda el microcontrolador en ejecutar una tarea viene

fijado por la siguiente férmula:
Tiempo = 4(1/f)cm

Siendo:

f = la frecuencia del oscilador.

cm = el nimero de ciclos maquina que tardan en ejecutar la tarea.

A continuacion se presenta un ejemplo practico para entenderlo de una

mejor manera.

Ejemplo: Calcular la duracion de 1 ciclo maquina para un PIC16F84 que

utiliza un cristal de cuarzo de 4 MHz.
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Solucioén:

Tiempo = 4(1/f)cm = 4(1/4AMHZz)1= 1ps.

1.6.2 MEDIR TIEMPOS CON MAPLAB

Para calcular el tiempo de ejecucion de un programa o de una subrutina,
se puede contar el nimero de instrucciones que se realizan y multiplicarlos por
4 veces la frecuencia de la sefial de reloj o por 8 en el caso de que las

instrucciones sean de salto.

El MPLAB dispone de una opcién de cronémetro denominada Stopwatch
gue permite medir el tiempo de ejecucion de las instrucciones de los

programas.

El cronémetro Stopwatch calcula el tiempo basandose en la frecuencia
del reloj del microcontrolador PIC que se esta simulando. Es necesario fijar
previamente la frecuencia del oscilador empleado, para eso, se activa desde el
menu Debugger > Setting > Clock tal como se muestra en la figura 1.15.
Inmediatamente se abre un cuadro de dialogo donde se fija la frecuencia de
reloj a 4 MHz.
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WOLAENUE et 2| x]

File Edit Wiew Project Programmer : : o
I | Clock |Bleak I:Iptn:nnsl Tlace.-’F'lnsI leltatlansl
Seleck Tool 4
DS E| %™
Clear Memary 4
n Fa Unitg:
un
) Frequency: " MHz
Animake  kHz
Halt F5 4 “ Hz
Step Inko F?

Step Ower F&
Skep Out
Resek 3

Breakpoints... F2

Stopwatch
Skimulus
Refresh PM

Aceptar Cancelar Aplicar

Figura 1.15 Seleccion de la frecuencia de simulacion en el MPLAB SIN

Después se activa la opcion Debugger > Stopwatch, con esto se
consigue abrir la ventana que muestra el tiempo transcurrido y los ciclos
maquina empleados en la ejecucién de cada instruccibn, como puede

apreciarse en la figura 1.16.

File Edit Wiew Project Programmetr Tools  Configure  Window  Help
~u Select Tool »
» [ S L
| b= | » Clear Memory * E ‘ J n 50 @
oo |
= | - ORRE C B
Anirmate
Halt Fa Stopwatch Total Simulated
Skep Inka F7 .
Spnch 1442200 1442200
1 Step Over Fa aunch | Instruction I:_I,Iclesl I
l ;TTTT .
i Step Cut Zew | Time (Sees) | 1.442200 | 1.442200
Reset 4 —
= ;
i 7 Por|  Breakpoints... F2 Processor Frequency [ MHz ) I 4.000000
Puert
- Skopwwakc : 2 x : :
4 Foan _"F s [ ‘Clear Simulation Time On Beset
inmtra  Skimulus
r --' ™ Refresh PM
SEttings”l _

Figura 1.16 Ventana con el contenido del tiempo transcurrido
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Es importante recordar que los simuladores de software no trabajan en
tiempo real. Hay que tener en cuenta que el cronometro del MPLAB trabaja
mucho mas lento que la realidad. Ahora bien, el tiempo que muestra sera el

tiempo real que tardan en ejecutarse las instrucciones.

1.6.3 INSTRUCCIONES “NOP”

Las instrucciones Nop (No Operation) no realiza operacion alguna. En

realidad, consume un ciclo maquina sin hacer nada.

La instruccion nop se utiliza para hacer gastar tiempo al microprocesador
sin alterar el estado de los registros ni de los flags. Esta instruccion tarda 1
ciclo maquina en ejecutarse. Asi, para un sistema con oscilador a cristal de

cuarzo de 4MHz, tendra una duracion de 1us (4 ciclos de reloj).

1.6.4 RETARDO MEDIANTE LAZO SIMPLE

En muchas aplicaciones con microcontroladores resulta necesario
generar tiempos de espera conocidos como tiempos de retardo . Estos
intervalos pueden conseguirse mediante una subrutina de retardo , basado en
un lazo simple de algunas instrucciones gque se repiten tantas veces como sea
necesario, hasta conseguir el retardo pretendido, figura 1.17. Como el tiempo
de ejecucion de cada instruccion es conocido lo Unico que hay que hacer es
calcular el valor inicial que debe tener el registro R_ContA, que actia como el
contador del niumero de interaccion en el lazo, para obtener el tiempo de

retardo deseado.
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call Retardo_x

A

Carga contador R_ContA con valores
iniciales “K”

>

A

Pequefio tiempo de espera

:

Decrementa R_ContA

SI

Figura 1.17 Estructura de una subrutina de retardo con un lazo simple
Un ejemplo tipico de subrutina de retardo puede ser siguiente fragmento de
programa, donde “cm” significa “numero de ciclos maquina” y en la figura

1.17 se muestra su diagrama de flujo.

Retardo 1ms ; La llamada “call” aporta 2 ciclos maquina.

moviw d"249” ; Aporta 1 ciclo méaquina. Este es el valor de k.
movwf R_ContA ; Aporta un ciclo maquina.

R 1ms_Bucle interno
nop

; Aporta Kx1 ciclo maquina.
decfsz R_ContA,F ; (K-1)x1cm (cuando no salta) +2cm (al saltar).
goto R1ms_Buclelnterno ; Aporta (K-1)x2 ciclos maquina.

return ; El salto de retorno aporta 2 ciclos maquina.

; Em total esta subrutina tarda:
; 2+1+1+kx1+(K-1)x1+(K-1)x2+2=5+4K=1001 ciclos maquina (para K=249).
; 1001 ciclos maquinas suponen 1 milisegundo (1001us) para cristal de 4MHz.

En el ejemplo el bucle de las instrucciones decfsz R_ContA,F y goto

R1ms_Buclelnterno se repite tantas veces como determine el valor con el que
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se carga R_ContA, en este caso 249. Cuanto mayor sea esta constante, mayor

sera el tiempo de retardo.

Es facil deducir que el valor de la constante “K” con el que se ha cargado
inicialmente el contador R_ContA vendra dado por la siguiente ecuacion, donde

el tiempo viene expresado en ps:

Tiempo = 5+4k K= Tiempo-5/4

Para mayor entendimiento de esta formula se cita el siguiente ejemplo:

Calcular el valor de la constante K, para obtener una subrutina de

retardo de 500ps.

Aplicando la ecuacion se obtiene:

K=Tiempo-5/4 = 500-5/4 = 1237

Asi pues se elige K=123, obteniendo un tiempo de retardo real de:

Tiempo=5+4K =5 +4.123 =497us

El ajuste fino para los 500us exacto se conseguiria afiadiendo 3 instrucciones

nop al principio de la subrutina de retardo.

1.7 MPLAB

1.7.1 PASOS CON MPLAB IDE

1. Con el explorador de Windows acceder a la carpeta de Mis Documentos y
dentro de ella crear una carpeta que se llame “PIC16F84”, donde se iran
guardando todos los programas que se vayan disefiando. La trayectoria
absoluta o path del fichero no puede superar la longitud maxima de 62
caracteres, esto es importante tenerlo en cuenta si se trabaja en Windows

2000 o XP donde los path absolutos suelen ser bastante largos. Asi pues,
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2.

el sub directorio donde se guardaran los ejercicios sera del tipo
“C:/Misdocumentos/PIC16F84” o similar.
Inicializar el programa actuando sobre el icono correspondiente a MPLAB

situado en el escritorio. Se entrara en una pantalla similar a la figura 1.18.

[« IMPIRBNDEN D AEE

File Edit “iew Project Debugger Programmer Tools  Configure  Window  Help

[DEd|[sma |82 | desm®

3‘»‘.\||@

| | PIC1EFE4A | | |

Figura 1.18 Pantalla de inicio del MPLAB IDE

A continuacion se entra en la pantalla de edicion, que al maximizar la hoja
de trabajo queda como la figura 1.18.

Elegir el tipo de microcontrolador. Para ello acceder al menu Configure >
Select Device y seleccionar PIC16F84, tal como se muestra en la figura
1.20.

A continuacion es conveniente seleccionar el simulador, para ello activar
el menu Debugger > select Tool > MPLAB SIM, tal como se muestra en la
figura 1.21.

La frecuencia de trabajo del MPLAB SIM debe coincidir con la del circuito
a simular. Para seleccionarlo acceder a Debugger > Setting > Clock y
después comprobar que estd a 4 MHz, tal como se muestra en la figura
1.22.

Crear un nuevo archivo fuente, para ello ir al menu File > New (ver en la
figura 1.19). Se entrara en la pantalla de edicién en blanco donde se

puede escribir el primer programa.
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A continuacion se da el nombre al fichero fuente accediendo al menu File

> Save As... Aparecera un cuadro de dialogo que solicita el nombre del

archivo. Se puede nombrar por ejemplo “Ensam_03.asm” y se guardara

en la carpeta “C:/Misdocumentos/PIC16F84” creada anteriormente.

AaEE|

| 5 —
A EE) SRS B I e L B M T e )
m Edit Wiew Project Debugger Programmer Configure  Window
Hel Chrl+1 - O x
open. .. k4D
£t —
C Close 0 @
1 J—
e,
Sawve As,.,
Open Workspace, .,
Save Workspace
Sawve Workspace As. .,
Irnpork. ..
Expork. ..
Recent Files L
Recent Workspaces
Exik 1
-
PIZ16F544
Figura 1.19 Pantalla de edicion de programa en el MPLAB IDE
o PTG DR DL e ]| AEE]

[J File Edit Wiew Project Debugger Pragrammer

(== s ==

Microchip Programmer Tool Support

@ PICSTART Plus @ MPLABICD 2
@ PRO MATE Il @ PICkit1
) MPLAB PM2

Microchip Debugger Tool Support
& MPLAB SIM @ MPLABICD 2
@ MPLAB SIM30

MPLAB ICE 2000 MPLAB ICE 4000
‘OPcmmxm ‘ONU Mudule

ok | cancel | Hele |

Configuration Bits...

ID Mermory. ..

Settings...

03bFF

Lni,

o

Figura 1.20 Seleccion del microcontrolador.
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Figura 1.21
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Figura 1.22 Seleccion de la frecuencia de simulacion para el MPLAB SIM
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8. Para trabajar con mayor comodidad es conveniente visualizar el nimero
de cada linea. Para ello seleccionar el menu Edit > Properties. Dentro de
la ventana Editor Options y pestafia Editor se activan las opciones que se

indica figura 1.23.

-, . - ) C o b Y7 . ) - 11
BN LD UE b - [T En S e sl SE M sad CEimE NS AEIS Lo (SH Rt 3 oes j hj

—1 File “iew Project Debugger Programmer Configure  ‘Window  Help - 8 x
= [“? H = = 2 DL BT g
g T
Editar lText ] Tabz ]
Select Al Chrl-& .
Line Murnbers  [» E nable “ariable
Find. .. Crrl+F \hl:loluseover I~
Find Mext F3 Ao 1 ales
Eenl ctrleH Prinit Lire ~
eplace. .. v+ Murnbers Show Address
Go Ta... Chrl4+G in Mouzeover
Enable Color
Match Chrl+m Printing r Double Click
Toggles rd
wordwiap W Breakpoint
Find “rap =
Auto |ndent rd Messagebox
Protect Read
Dy files r
Aceptar Cancelar

Figura 1.23 Propiedades de la pantalla de edicion.

9. Elegir el tipo de letra, activado en el menu Editor > Properties. Dentro de
la ventana Editor Option se activa la pestafia Text y se elige el tipo de letra
seleccionada en la figura 1.24 o aquél otro tipo que al lector le resulte
cémodo para su forma de trabajar.
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Edtor Ted | Tabs |

Fonts
Select the Edit
Select Font FDEnBLC Fra

Mational Language Code Page:

‘1252 [AM3] - Latin)

Colars
Select the context
Chooss Colors sensitive calars.
Default Colors

Areptar | Cancelar |

Fuente Estilo de fuente:
M omal
1]
T Courie Cursiva g
(} Culz MT , |Meaita 10
I Dauphin Megrita curgiva 11
B DavidaD 12
T DavidalniD 14
B Devinnelm 16
Ejemplo
LaRhTyiz
filfabeto:
|Elcci|:|enta|

Eta es una fuente DpenType. E sta mizma fuente s usard tanta en
S impresora como en su pantalla.

Figura 1.24 Eleccion del tipo de letra.

10. A continuacion hay que seleccionar la tabulacion deseada, activando el
menu Edit > Properties. Dentro de la ventana Editor Options se activa la

pestafia Tabs y se elige el valor indicado en la figura 1.25 o aquel que se

crea conveniente.



Eeliiur Duilugs ._.hjl

E ditar ] Tewt  Tabs l

™ Inzert spaces

Tab zize: 2
[1-18] {* Keeptabs
Drefault
Window Size: =]
[10-80]

Lceptar | Cancelar |

Figura 1.25 Eleccion de la tabulacién.

11. Es conveniente dejar los colores de los caracteres configurados por
defecto. Dentro de la ventana Editor > Properties. Dentro de la venta
Editor Option se activa la pestafia Text y el boton Default Colors (figura
1.24).

12. Es cémodo que cada vez que se abra el MPLAB aparezca el ultimo
programa con el que ha trabajado. Para ello, hay que activar el menu
Configure > Setting > Workspace y activar la casilla Reload last workspace

at startup (figura 1.26).

SELLINES J ;3
“Workspace | Program Laading] F'raiectsl

Automatically zave workspace upon clozing
" Yes " Mo {* Prompt

[v FReload last workspace at startup
[v Save files before running the debugger

W Remove breakpoints upon importing a file

Recent file lizt containg: 10 files
Recent workzpace list 4 work space

Aceptar | Cancelar |

Figura 1.26 Configurar la recarga del ultimo trabajo realizado al abrir el MPLAB.
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13. En la pantalla de edicion se procede a escribir el programa.
Es importante recordar que “_ _ CONFIG” se inicia con dos subrayados
(guiones bajos), no con uno.

14. A continuacion el programa se ensambla y simula tal como se explica en
los proximos apartados.

15. Una vez simulado el programa y corregido todos los errores se puede salir
del MPLAB por el método habitual en Windows, activando para ello el
menu File > Exit.

1.7.2 ENSAMBLADO DEL PROGRAMA

Una vez terminado de editar el programa hay que proceder a ensamblar
el archivo fuente Ensam_03.asm. Para ello, hay que seleccionar el menu:
Project > Quickbuild Ensam_03.asm,

0 mejor combinar con la combinacion de teclas Alt+F10 (figura 1.27).En esta
etapa se realiza en forma automatica el ensamblado del archivo en forma
automatica el ensamblado del archivo fuente y el traspaso de éste a la memoria

de simulacion.

w INPIRB NI 0 A Ee a0 S sas | =13}
[] File Edit ‘iew Debugger  Programmer Configure  Window Help - a x
,, Project Wizard. ..
= r S REE i
Mew. .,

l ;*******1 Exthhrhrhhrrhrrrhrrrtrrrdrrdrrrrrris

) Open... ) -
z H This aszembly code generation *
i H o T Close wtains the basic code *
4 : paild  oet Ackive Project 4 =
5 H *
1= ; If ix gented between the ORG *

Figura 1.27 Ensamblar el archivo fuente

Momentaneamente aparecerd una ventana indicando el proceso de

ensamblado (figura 1.28).
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Figura 1.28 Proceso de ensamblado

emowved. In

Al finalizar el ensamblado, aparecera una pantalla MPLAB — Output tal
como muestra la figura 1.29, en la que indicar& la ocurrencia de uno de estos

dos casos:

rD I EEI

Build | Wersion Contral | Find in Files |

PSS JUE ] eALIIALIE T LD AL ST TIPS E IS LA VI UD'I,I‘.‘@l
tessage[302] CADOCUMENTS AMD SETTIMNGSYUSERWIS DOCUMENTOSY —
Errar[173] CADOCUMENTS AND SETTINGSVWISERMIS DOCUMENTOSFALS
Errar[173] CADOCUMENTS AND SETTINGS\UISERMIS DOCUMENTOSVFALIZ
Halting build on first failure as requested.

BUILD FAILED: Mon Dec 25 19:33:57 2006 B

*r | B

Figura 1.29 Pantalla final de proceso de ensamblado con éxito

. Si al final de esta pantalla indica “BUILD SUCCEDED” se confirma
gue el ensamblado se ha producido con éxito. Por lo tanto, ya se esta en
condiciones de pasar a la simulacion. En esta pantalla pueden aparecer
algunos mensajes de aviso “Message” , que llaman la situacion sobre
situaciones a tener en cuenta y que podria ocasionar un error en el

programa pero que no impide el correcto ensamblado.
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. Si al final de esta pantalla indica “BUILD FAILED” se advierte de
la ocurrencia de errores. El proceso de ensamblado ha generado un archivo
de error con descripcion de los mismos. Si se hace doble clic sobre la linea
gue muestra el error el cursor saltar4 directamente a la linea de cédigo
donde se encuentra éste. Una vez subsanados los errores hay que volver a

ensamblar el archivo fuente.

1.7.3 FICHERO HEXADECIMAL RESULTANTE

El proceso de ensamblado produce un fichero ejecutable con extension
(*.hex) que seréa el que posteriormente se grabara en la memoria de programa
del PIC mediante el grabador. Este fichero puede ser analizado seleccionando
el menu File > Open y dentro de los tipos de archivo All Files (*.*) se ha de

elegir el Ensam_03.HEX, tal como se muestra en la figura 1.30.

Ensam_03 ) Ensam_03
Archivo A3 aagl | CODFile
22 KB —=1 | Z1KB

Ensam_03
Errar log [z
3KE

E,

Ensam_03
Archivo LST
29 ke

Figura 1.30 Abrir el archivo resultado del ensamblado en cédigo maquina*.Hex

[ File Edit ‘Wiew Project Debugger Programmer Configure  Window  Help - O x
"] A -
O B 8% o=
1 SOZ0000040000FA -
= Sl0000000331568601FFI0850058312Z0500555000523C7
2 ;OZ400EQ00FL13FE0
4 ;0000001FF

Figura 1.31 Contenido del archivo resultado del ensamblado del c6digo maquina

En este archivo Ensam_03.hex Unicamente contiene ndameros

hexadecimales, que es la forma de representar los ceros y unos binarios de la
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informacion que se grabara posteriormente en la memoria de programa del

microcontrolador.

1.7.4 VENTANA DE VISUALIZACION

Una vez ensamblado el cddigo fuente el entorno ya esta preparado la
simulacién del programa. Para que este trabajo sea mas eficaz conviene
activar las ventanas que indica el estado de todas las memorias y registros del
sistema. Las principales ventanas de simulacion se encuentra dentro del menu
VIEW y son:

. Disassembly Listin. Codigo maquina y archivo fuente.
. File Registers. Memoria de programa.

. Program Memory. Memoria de programa.

. Special Function Registers. Registro del SFR.

. Watch. Ventana personalizada.

L WDIRBND VDR A=
File Edit [ W=00 Project  Debugger  Programmer Configure  Window  Help
D o o o [ b BT RR
Oukpuk
1 Disassembly Listing ___j -
m Hardware Stack. »
Prograrn Memory ] P OB ETDI
a File Registers | Line | Lddress | Opeode | Di
EEPROM
2 e 1 3FFF LDDLY
wiakch Z oool 3FFF ADDLW Oxff
? Special Function Registers B ? ooz SFFF ADDLI Dxff
4 ooo3 3FFF ADDLW Oxff
5 Simulatar Trace 5 o004 3FFF ADDLT Oxff
& oogs 3FFF ADDLW Oxff
* 7 oooe 3FFF ADDLW Oxff
= ; If interrupts are not
ane * Opcode Hesx || Machine Symbolic
7 ; Ox004 directive and the lakel main can be remowed. In

Figura 1.32 Ventana de visualizacién de la memoria de programa.
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1.7.5 VENTANA DE VISUALIZACION DE LA MEMORIA DE PROGRAMA

En esta ventana se aprecian las posiciones de memoria que ocupa cada
una de las instrucciones, el cddigo de operacion de cada instruccion y la
direccibn de memoria de programa que se le ha asignado a cada etiqueta
(figura 1.32). Se encuentra en ella actividad el mena Viuw > Program Memory.

1.7.6  VENTANA DISASSEMBLY

Esta ventana incluye el archivo fuente. Se entra en ella activando el

menu View> Disassembly Listing, como se ve en la figura 1.33.

w IMPIABIDEVEA0 ] Disassemblylbshng] =3
-

] File Edit Project Debugger Programmer Configure  Window Help - 8 x
D oo @ bbb ® TR B
v Oukpuk
11z:  fin led £xt j
113: ; b=sf INTCOM, GIE =
Hardware Stack 114- ENDHM
Praogram Memory 115-
File Registers Lle: 1
EEPRICM 117:
11g:
Watch llg: ;************************
Special Function Registers 1z0: HRG DX?DD
= oooc : 121: goto main
Simulator Trace lzz:
123: aRG Ozx004
o000 azc MOTWE Oxc 1z4: mowwrE w_tenp
aooaooks 203 MOVE OxZ, W 125: movE STALTUS o
oooo0o0e 0D MOWIE Oxd lZg: morrE status_tTen
127:
aooao? 1EZE BTFS5S5 Oxb, OxE 1z3: btfzs INTCON, TC
aoooog Z20B EOTOD Oxh 1z9: goto =43
aoooo2 120EB BTFSC Oxb, OxZ 130: btf=zc INTCON, TC
aooooa Z98F EOTOD Oxzl1:2f 131: goto interrup_t
132:
aooooe 138k BTESS Oxb, 0Ox3 133: btfss TINTCOM, EBE
aooooc Z80F EOTOD Oxf 134: goto s+3
niulululnie} 130E BTESC 0Oxb, 0O 135: btfsc INTCOM, EBE
00000k ZOAC GOTOD Oxlac 136&: goto interrup_r
137:
128 = der onda man ome hnvn:lj
| KN — b
MPLAE 3IM PIC1GFG44 pc:0 w0 zdcc Ox02c2

Figura 1.33 Ventana Disassembly
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1.7.7 VENTANA DE VISUALIZACION DE LOS REGISTROS DEL SFR

Para visualizar los registros especiales del SFR se activa View > Special

Function register (figura 1.33).

[
MPLAB DAL A=
Fil=  Edit Project  Debugaer  Proarammer Configure  Window  Help
~u PI’DjEEt se oy Th T il
O & » Output s pounoer ¢ R E
—
| Disassembly Listing L Spzekil Fineriu flagisers - |[B][%]
| Hardware Stack -
b Address + | 3FER Name | BEinarvy | Hex ||
rogram Memary
[ File Registers ? E’[T;gg
EEHHLIM
aool THRO gooooooa oo
watch aooz PCL gooooooo oo
—— . . aoos ITATUS gooiiooo 15
Spacial Function Pegistars o004 FaR Qoooooon an
simulabor Trace o005 FORTA 00000000 oo
aooea PORTE gooooooa oo
aoos EEDATAL oooaooaon oo
aoos EEADE gooooooo oo
* T vula M i PCT.ATH nnnnnnnn nn
QooE INTCON gooooooo oo
o051 OPTICH REG 1131113111 FF
oO0004 nac 0085 TRISL 00011111 1F
00oaos 2032 oosa TRISE 11111111 FF
4 aass EECCI1 gooooooo oo
Ui B RO uaaouag (11
& T 3]

Figura 1.34 Ventana de visualizacion de los registros especiales

Para modificar manualmente uno de estos registros hay que hacer doble
clic en la fila del registro correspondiente sobre alguna de las columnas Hex,
Decima, Binary, o Char y modificarlo. Esto no es valido para los puertos que
actien como entrada, en cuyo caso hay que utilizar, dentro del menu,

Debugger, la opcién Stimulus.

En esta ventana suele ser interesante situar la columna Binary a
continuacion de la columna SFR Name. Para ello, pulsar el botén derecho del
raton y elegir la opcion Properties, saldra una ventana como la que se muestra
en la figura 1.35. Sefalando la casilla Binary y pulsado sobre el botén Move
Up, la columna Binary se desplazara hasta situarse en la posicién deseada tal

como se explica en la figura 1.35.
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» WPIABIDEV G0 I pecalmction iesister

] File Edit Wiew Project Programmer i
Calurn Settings
0 & El Select Tool r
Clear Memary 4 E %he;k theuculumdn;that 'IE)DU wu:u;lu:tltlike :-'isil:ule ciln tT;s vieui\l. ze
the Mowve Up and Mowve Down buttons to reorder the columnz
Address | % Run Fa lE hiowweser _I,IDE like.
0000 INDF | animate I-
WREG JC Address Mave Up
ooo1 THERO Skep Inko F7 dc Binary
oooz PCL Skep Ower Fa - SFR Mame M
ooo4g F3R Step OUE ac Hex
0oos PORTA Reset y 26 Decimal
0006 PORTE L Char Hide
aoos EEDAT Breakpoints... F2 ac
ooog EEADR ac Defaultz
000 PCLAT  Stopwatch oc
OO0E INTCo  Stimulus or Selected column l—
ooss EECOI Refresh PM ac width in pisels:
aose EECCH Settings... ac
aoos ATATO ac
aoss TRIZL oac
oos1 OPTIOM REG 111
noZs TRISE 111 Aceptar Cancelar Aplicar

Figura 1.35 Desplazar la columna Binary dentro ventana de visualizacion del SFR

1.7.8 VENTANA DE CONTENIDO DE LA MEMORIA RAM

Esta ventana presenta una lista con todos los registros generales del
microcontrolador simulado figura 1.36. Para visualizar la ventana de contenido

de la memoria RAM de datos hay que seleccionar View > File Register.
Activando el botdn inferior Symbolic se puede visualizar el nombre

simbdlico que le ha dado el programador a las diferentes posiciones de

memoria RAM de usuario.
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s IMPIRBND V0! M=E3)

File Edit “iew Project Debugger Programmer Configure  Window  Help
O & BE 8% oeE pooner R EE
O
qoooon 130E BTESC 0Oxb, 0O 135: btfsc INTCD]:EI
OO000E Z3nC GOTD Oxlac 136: goto inter
137:
13%: ; isr code can go her—
133: fin interrup
140:
aoooor 200 MOVE Oxd, W 141: morE Status
aooola o33 MOVHE 0Ox3 14Z: morerE STATINE
ooooll EzC SVAPF Oxc, F 1d4z: =svrap £ W_temg
aooolz EQC SVAPE Oxc, W 144: svrap £ W_temy
aoool3 aos RETEIE 145: retfie
146:

L Rl fagistars JJQIl
iddress | 00010z |03 04|05/ 06|07 05| 02| oafoE|oc|on|oE|oF| LSC
aooo oo 00 18 00 OO0 0O —— OO0 0O QOO OO 0O 0O OO0 00 —.. ... -
aoio oo o0 OO 00 0O 00 00 OO0 00 00 OO OO0 00 00 00 00 o..wewws .

oozo oo o0 00 00 00 00 00 OO0 00 00 00 00 00 00 00 00 o. e ewas
aoso oo o0 OO 00 0O 00 00 Q0 00 00 o0 o0 00 00 00 00 ... ....
ao4o oo o0 OO 00 0O 00 00 OO0 00 00 OO OO0 00 00 00 00 o..wewws —
aoso —_— == m= m= m= m— m— —— e = = e
| |
Hex Symbolic|

Figura 1.36 Ventana con el contenido de la memoria RAM de datos

1.7.9 SIMULACION BASICA

Tras el proceso de ensamblado se procede a la simulacion del
programa. Mientras se ejecuta la simulacion del programa es interesante
visualizar el contenido de las ventanas explicadas antes y comprobar el efecto

de cada una de ellas.

Es conveniente antes de nada, comprobar que estd cargado
correctamente el MPLAB SIM.

Los cinco comandos mas importantes para la simulacidon se localizan

dentro del menu Debbuger y se muestra en la figura 1.37.
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s [MPIABUDEvE 40 [(GoA v AEnEam 03 baem] =13
-

] File Edit View Project Programmer Configure  Window  Help - 8 x
Select Tool »
O = 2 e ™ O P
Clear Memoty 3 NURLS @
55 w_temnp E Run Fao ; variable used for context saving j
== status_tewmp E . ; variable used for context saving
=0 Animate
—
51 CELOCE 0x0E
=4 Horas, Step Into F7 Aux_Tiewpo
52 Cont, C Step Ower Fa b, RBeg dlyZ, Peg dly3
=E] LCD_ATTA] Step Cuk LS, MOLO, MODO AL
55 Cont_chyf Resat p o, TECLE_ANT, Dato_AuxH, Dato_luxL
=13 Hum_ A1 s i
&7 Horas A Breakpaints. . F2 ¢ Alarma

&2
=]
70
71
7E
73

END:C

Stopwatch
Stimulus

#define LCD_LE Refresh PM
#define LCD_E
$define LoD _pom  Sethings..

Figura 1.37 Menu para entrar en los comandos basicos de simulacion

Run. Modo de ejecucién continua. Ejecuta el programa
constantemente. Las ventanas abiertas en el paso anterior no se
actualiza hasta que no se produce una parada. Es la forma mas
rapida de simular el programa, pero no se “ve” ni como evoluciona
la memoria ni los registros. En este modo se entra seleccionando
Debugger > Run o pulsando la tecla F9, también al pulsar sobre el
icono correspondiente de la barra de herramientas (flecha azul).

ANIMATE (o tecla ctrl.+F9). Modo de ejecucion animada.
Ejecuta el programa de forma continua pero actualizando todas
las ventanas cada vez que se ejecuta una instruccion . Es mas
lento que el modo “Run” pero permite ver como va cambiando los
registros. Tal vez sea el modo de ejecucibn mas dutil y
recomendable. Se entra en este modo seleccionando Debugger >
Animate, o también al pulsar sobre el icono correspondiente de la
barra de herramientas (doble flecha).

HALT. Paro. Para la ejecuciéon del programa y actualiza todas las
ventanas. Se consigue seleccionando Debugger > Run o
pulsando la tecla F5. También se entra en este modo al activar el
icono correspondiente de la barra de herramientas (dos barras
verticales azulez).
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STEP INTO. Ejecucién paso a paso. Ejecuta una sola instruccién
del programa cada vez actualizando los valores de la ventana. Es
la forma mas lenta de simulacion pero se comprueba facilmente
como van evolucionando todos los registros y memorias, siendo
muy facil detener los posibles errores. En este modo se entra
seleccionando Debugger > Step Into o pulsando la tecla F7.
También pulsando sobre el icono correspondiente de la barra de
herramientas.

RESET. Equivale a un reset por activacion del pin MCLD. En este
modo se entra seleccionando Debugger > Reset o pulsando la
tecla F6. También si se pulsa sobre el icono correspondiente de la
barra de herramientas.

RUN TO CURSOR. Ejecucion hasta la posicién actual del
cursor. Para entrar en este modo de simulacion, el cursor debe
situarse en la linea donde ésta la instruccion hasta donde quiere
simular el programa, pulsar el boton derecho del ratén y activar la
operacion Run to cursor tal como indica la figura 1.38.

L e s i Sa s \Usa p s due iz s \F\E s U asm) _J_J \j

111
112
113
114
115
116
117
1158
119

120

107 incf  PCLATH j
Log movef UL

103 Tut Set Breakpoink _
L10 DT TEXE0 Brecknaints '

fin led txt

: bsf INTED) et pC at Cursor
ENDIL

;*****************TTT - e e e e e e e e o e e R

EEEEEE

ORG processor reset j

Figura 1.38 Modo de simulacion “Run to Cursor”
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1.7.10 SIMULACION MEDIANTE BREAKPOINTS Y TRAZA

Un punto de ruptura o BreakPoint es un punto o instruccién donde la
ejecucion del programa se detiene, por ello también se le suele llamar punto
de paro, permitiendo el andlisis del estado del microcontrolador. Para continuar

la ejecucioén del programa hay que volver a pulsar sobre Run o Animate.

ﬂ A EAEE DR = [ e gz i el Jgiiles = e WiTs doe iz ius \F L e U5 | j j;j

] Eile Edit Wew Project Debugger Programmer Configure  Window Help - a x
O = 8 %7 owE L R i

174 bsf EANDERLS, Txt z‘

175 b=t EANDERALZE, TxtZ

176 call LCD_INT

177 clrf TECLL

178 clrf TECLA_ ANT

179 -

150 Loop

151 clrf PORTE

122 b=sf INTCOM, BEIE

pee Breakpoints 4

124 LoopZ

125 btf=ss EANDERALZE, Txt Run ko Cursar

186 goto Loops Set PC ak Cursor

1587 bcf INTCOM, BEIE

1588 bcf EANDERAZ, Txt

189 clrf PCLATH

Figura 1.39 Situar un Breakpoint

Para situar un Breakpoint sobre una linea sefalada por el cursor se
pulsa el boton derecho del ratdén, de manera que aparece el menu desplegable,

como en la figura 1.39.

Selecciona Set Breakpoint y aparecera sobre el programa una “B” en
rojo en la posicion donde ha situado el punto de paro. Otra forma de situar o
eliminar un Breakpoint es realizando una doble posicion con el raton sobre el

namero de linea donde se quiere situar el punto de parada.

La ventana de memoria de traza es una herramienta que ayuda a
simular los programas (figura 1.40). ElI Simulate Trace toma “una instantanea”
de la ejecucién del programa. En el simulador de buffer de traza o memoria de
traza es util para visualizar un registro a lo largo de la ejecucion del programa,

de manera que se puede registrar por donde pasa el programa y después

70



analizarlo. El simulador toma datos desde la ultima vez que se pulsé Run o
Animate hasta que se detiene la simulacion del programa (normalmente hasta

un Breakpoint).

P LS DE v6.1U - lrae| M =1E3
[ Eile  Edit Project  Debugger  Programmer Configure  wWindow  Help - T x
D= Frolec - @ S R e
v Oukpuk
Disassembly Listing
Line L Hardware Stack truction Sh s AL oo Cyoles
Program Memory
27 0! Fje Registers 0x357 W -— W F9 )0000Z743
28 O  EEpROM ———— —— ———— —- 100002744
== I 2Z Ox14, FOO14 05 0014 07 10000274E
0 o wakch Ox337 L) - 1) Fo 10000274C
3L O Special Function Registers ~--= -7 —To— - 1DDhDzY4aE
32 SZ Ox14, FOOl14 07 0014 06 10000274F
33 0O Ox3387 L) - 1) F9 100002750
34 Odgyoooo i L —_——— == ———— == 0000z752
35 0385 O0EBS4 DECF23Z 0x14, FOO14 06 0014 05 100002753
36 0389 ZEBES7 GOTD 0x387 L) —— o F9 100002754
37 0387 0000 NoP ———— ——= ———— —— 100002758
28 0388 0ES4 DECF2Z 0O=x14, FOO14 05 0014 04 100002757
9 0382 2EE7 GOTO Ox3s7 L) - 1) FO 100002758

Figura 1.40 Simulacion de traza

Para visualizar la ventana de memoria de traza hay que seleccionar el
menu View > Simulate Trace. El simulador muestra en la ventana Trace
cualquier variacion sobre los registros al ejecutar el codigo de instruccion. Esta

ventana tiene las columnas cuyos significados se citan:

e Line. NUmero de lineas ejecutadas desde que se pulso Run por
altima vez.

» Addr. Direccion de la memoria de programa donde se encuentra
la instruccion.

* Op. Codigo de operacion numerico de la instruccion.

» Label. Etiqueta de la instruccion si la tuviese.

* Instruction. Instruccién ejecutada.

e SA. Direccién numérica del registro fuente.

» SD. Dato del registro fuente.

* DA. Direccion numérica del registro destino.

» Cycles. Ciclos maquina transcurridos.
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El contenido de la memoria traza se puede salvar a un fichero para un
posterior andlisis. Para ello, estando situado sobre esta ventana pulsar el botén
derecho del raton y seleccionar Output to File.

1.7.11 SIMULACION DE ENTRADAS

Una de las operaciones mas habituales de cualquier simulacién consiste
en variar los valores de las lineas de entrada. A esto se denomina “estimular” la
entrada. Para cambiar los estimulos de una entrada de un puerto hay que
seleccionar el menu Debugger > Stimulus. En la ventana que aparece,

selecciona la pestafia Pin Stimulus (figura 1.41).

. N
w IPIRBNDEN 0 )=l E3
File Edit Miew Project Debugger Programmer Configure  Window  Help
~a Al ;|
D= 7T oeE L R E
llg :_******‘k‘k‘k‘k**********‘k‘k************‘k‘k‘k‘k**************************
TEEETETE
120 OB Ozx00o0 ; processor reset
wector
121 goto main ; go to beginning of
pProgram
122
123 Rz Oz004 ; dAnterrupt wector

O B e Sidn s

Pin Stirnulus l File Stimulus |

Pitt Stirmulus file

Add Bow | Delete Row ‘ Edit Qomplete‘ Load | Save
Type | Enahle | Pin| JLctiDn| High eyoles | Low cwyoles | Invert | Corm

Figura 1.41 Menu para entrar en la ventana de estimulos

Si pulsa sobre Add Row , se iran afladiendo diferentes filas. Cada una de
estas filas corresponde a un estimulo sobre una linea de entrada. La forma de

editarlo es pulsar sobre la casilla correspondiente y seleccionar la patilla a la
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que se quiere vincular y | tipo de cambio que se desea realizar con ese pin para

cada pulsacion.

* High, poner la entrada a “1".

* Low, poner la entrada a “0”.

« Toggle, cambiar de valor cada vez que se pulse. Esta es la mas
habitual.

* Pulse, cambia el estado del pin y retorna de nuevo a su valor

actual.

La figura 1.42 muestra como se ha configurado para las cinco lineas del

puerto A, como entrada y en modo Toggle.

P ST IE

Pin Stimulus l File Stimulus |

Pir Stirmuluz file

Add Row | Delete Row | Edit Qumplete‘ Load | Save

Type | Enable| Pin| J‘;ction| High cycoles | Lowr cyclesl Inwvert | Com
b... Fire EL3 Toggle
A... Fire RAD Toggle
A... Fire RALZ Toggle

Fire RAE4 Toggle

ho..

[aos =] Fire 7 ~][rosen | L
High
Lowr

Pul=se

Figura 1.42 Configurar los estimulos para el Puerto A como entrada y modo Toggle

Tras pulsar el botdén fire habra de ejecutarse la siguiente instrucciéon
antes de ver los cambios a través de las ventanas de visualizacion.
Es posible salvar la configuracion realizada mediante el boton Save para

recuperarla en posterior ocasion con el botén Load.
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1.7.12 GRABACION CON EL ARCHIVO HEXADECIMAL

Una vez simulado el programa y comprobado que funciona
correctamente, es tiempo de grabar fisicamente dicho programa en el
PIC16F84. Con el ensamblado del archivo fuente se ha generado un archivo
ejecutable con los cddigos maquinas a grabar en el PIC16F84. Este archivo
tiene extencion *.hex y se graba en el PIC16F84A con ayuda de un grabador y

el sotware asociado. Para ello deben seguir los siguientes pasos:

» Conectar el grabador al ordenador. Insertar el PIC16F84 en el
z6calo correspondiente, teniendo en cuenta la orientacion
correcta del chip guiandose por la muesca de la capsula.

e Abrir el programa y comprobar que esta correctamente
configurado.

» Abrir el archivo co extencidon *.hex que contiene los datos a
programar en el PIC16F84A. Para ello, seleccionar el menu
Archivo > Abrir archivo y, una vez dentro de la carpeta apropiada,
elegir el fichero a grabar.

« Comprobar que los datos se han cargado en el area de Cdédigo de
programa.

* Proceder a la grabacion fisica del chip.

* Una vez grabado el PIC16F84 se debe extraer del grabador y

comprobar su correcto funcionamiento dentro del circuito.

1.8 SOFTWARE DE GRABACION IC-PROG

El IC-Prog es uno de los softwares mas populares para la grabacion de
microcontroladores PIC. Permite la programacion de muchos dispositivos y
estd probado con numerosos programadores. Es de libre distribucién y en la

pagina Web www.ic-prog.com se puede descargar y recoger toda la

informacion de uso.

Una vez descargado, la instalacion de este software es muy sencilla,
basta con descomprimir el fichero icprog.zip y seguir el procedimiento usual en
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Windows. Este archivo consta del fichero icprog.exe, que contiene todo el
codigo necesario para su funcionamiento, con versiones para cualquier sistema
operativo Windows. En caso de utilizar este software con Windows XP, 2000 o
NT, es necesario descargar el archivo icprog.sys de la misma Web y situarlo en

la misma carpeta, junto con el icprog.exe.

1.8.1 PROCESO DE GRABACION

Antes de nada hay que conectar el programador a uno de los puertos
serie COM disponibles en el ordenador. A continuaciéon se inserta el
microcontrolador PIC en el zocalo del programador respetando la correcta

orientacioén de la capsula.

Una vez que el programa esté correctamente instalado, los pasos a

seguir para trabajar con el IC-Prog 1.05C son los siguientes:

1. La primera vez que se ejecuta entrara en una pantalla de
presentacion de la que sale aceptando todas las opciones por
defecto. Seguidamente aparece una pantalla en inglés, similar a la
figura 1.43, donde se presenta toda la informacion necesaria para
programar el dispositivo. Esta pantalla posee, al menos:

* Un éarea de codigo (Program Code), donde se almacena la
informacion a grabar. La columna de la izquierda contiene la
direccion fisica de la memoria del dispositivo, (Address). En el
centro del campo se presenta el valor hexadecimal y la columna
de la derecha contiene la misma informacion en codigo ASCII.

e Un area de configuracion (Configuration), donde se indica el
valor de algunos parametros necesarios para la correcta

grabacion
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|% [€-Mrog | UaC- Brodpsiplur 2 uruigiings J Id

Archivo  Edicion Bufer Ajustes Comando  Herramientas  Ver  Ayuda

=-d T F | $%S % BE EEEEET - | X

Direccidn - Codigo programs Configuracidn
0000: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF iy
0008: 3IFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF ¥yyvyvyy
0010: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF $yyvyvyy
0018: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF Wy Wyvyy
0020: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF ¥Wyvyyyy
0028: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF $yyvyvyy
0030: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF iy
0038: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF iy
0040: 3IFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF $yyvyvyy
0048: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF Wy Wyvyy Bits configuracion:
0050: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF ¥Wyvyyyy WV WOT

O=ciladar:
RC -

0058: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF $yyvyvyy - T

Direccion - Datos Eeprom r cp :

0000: FF FF FF FF FF FF FF FF ¥¥iivivy

0008: FF FF FF FF FF FF FF FF ¥¥¥¥yyvy

0010: FF FF FF FF FF FF FF FF ¥¥y¥yyyyy

0018: FF FF FF FF FF FF FF FF ¥¥¥¥yyyy

0020: FF FF FF FF FF FF FF FF ¥¥¥¥yyyy

0028: FF FF FF FF FF FF FF FF ¥¥¥¥yyyy Checksum  Walor ID

0030: FF FF FF FF FF FF FF FF ¥¥irivivy 3BFF FFFF

0038: FF FF FF FF FF FF FF FF ¥¥¥¥yyvy Palabra config: SFFFh
Butfer 1 |Eluffer 2 J Buffer 3 J Buffer 4 J Buffer 3 ‘

JDh Programmer en Coms Dispostiva: PIC 16F&4 (131)

Figura 1.43 Pantalla tipica del IC-Prog

2. Para cambiar el idioma de debe seleccionar en el menu Setting >

Option > Language y elegir idioma (figura 1.44).
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By [0 Uiy 030 -

File Edit Buffer

=&

Address -

0oo0o0:
000a:
0o010:
0018:
0020:
0028:
0030:
0038:
0040:
0048
0050:
0058:

Address -

Progral
3FFF
3FFF
3FFF
3FFF
3FFF
3FFF
3FFF
3FFF
3FFF
3FFF
3FFF
3FFF

Protutyus Progriiizs

Command Tools  View Help

Device
Recent Devices
Hardware
Hardware Check

Smartcard (Phoenix)

Clear Settings

3EFF
3FFF
JFFF
3EFF
3FFF
3FFF
3FFF

Eeprom Data

3FFF
3FFF
JFFF
3FFF
JFFF
3FFF
3FFF

3FEF
3FFF
JFEF
3FFF
JFFF
3FFF
3FFF

4

3FFF
3FFF
3JEFF
3FFF
3FFF
3FFF
3FFF

Uuilugs

Confirmation | Wotification | FC
Drag & Drop ] Smartcard

3FFF
JFFF
3FFF
3FFF
JFFF
3FEF
3FFF
JFEF
3FFF
JFFF
3FFF
3FFF

3FFF
3FFF
3FFF
3FFF
3FFF
3FFF
3FFF
3JFFF
3FFF
3FFF
3FFF
3FFF

3FFF
3FFF
3FFF
3FFF
3FFF
3FFF
3FFF
3JEFF
3FFF
3FFF
3FFF
3FFF

Pleaze choose your prefered language

Language

English -

French
Portuguese
Dutch
ftalian
Russian
Greek

3

] Programming l Shortouts l
Language ] shell | Misc

l

3. Configurar

o |

Cancel

Figura 1.44 Eleccion del idioma

el

hardware

necesario

para  programar

los

microcontroladores PIC, es decir adapta el IC-Prog al programador

utilizado, en el caso que se ocupe un programador compatible con

JDM. Para ello hay que acceder al menu Ajustes > Tipo hardware,

con lo que aparecera la pantalla de la figura 1.45, en la que se debe

elegir el tipo de programador como JDM y seleccionar el puerto serie

adecuado (COM1 o COM2), segun lo tenga conectado en el

ordenador.

RIS S E T aTE

Programador:

JOM Programmer

Puertos

f* Com1

o

" Com 3

o

Retarda /0 (100

.

Irterfaz
f* Direct O

O windoves AP
Comunicacion

[ Invertir Data Out
[ Invertir Data In
[ Invertir Clock

[ Invertir MCLR

[ Invertir WCC
-

Cancelar

Figura 1.45 Seleccion del programador
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4. A continuacidén se debe seleccionar el dispositivo a grabar, en este
caso el microcontrolador PIC16F84, en el menu Ajuste > Dispositivo
> Microchip PIC > Mas > PIC16F84, tal como se describe en la figura
1.46.

5 |E2 M pog A E = Mg aidur da uruiuiiuos |

Archivo  Edicion  BuFer Comando  Herramientas  Yer  Avuda Mas
PIC 16C734
= - | M SR _ +-Wire Beprom b pic 12508 PIC 16C736
Dispositivas recientes ] I#Z Eeprom 4 PIC 1205054 PIC 160744
Direccion - Cadigo progy—— Tipo hardware F3 Flash piC 4 PIC 120509 PIC 16074
0000: 3FFF 3FF1 Pruebahardware IM-Bus Eeprom 4 PIC 1205094 FIC 16076
0008: 3FFF 3FF1  Opriones PIC 12CES18 PIC 16077
0010: 3FFF 3FF1 Smarktcard (Phoenix) Microwire Eeprom  F PIC 12CE519 PIC 16F72
0016: 3FFF IEFL - o ar siustes Serial Esprom ¥ pie 20671 PIC 16F73
gg;g: :gg :glﬂ 3FFF 3FFF 3FFF 3FF] :erla.l . : PIC 126672 PIC 16774
0030: 3FFF 3FFF 3FFF 3FFF 3FFF 3FF] SE?Ezpmm v E;E i;g:gj Eigi:g?
0038: 3FFF 3FFF 3FFF 3FFF 3FFF 3FF] oo - SR bl 16cad
0040: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFl —owws—osme——yr
0048: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF wyy 1-12F675 PIC 16FE3
0050: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF gy - 160433
0058: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF gy FIC 16054 PIC 16F344

Figura 1.46 Seleccion del microcontrolador.

El nombre del dispositivo seleccionado aparecera en una ventana de la
barra de herramientas (figura 1.47). Pulsando en la flecha de la ventana se

puede elegir cualquiera de los dispositivos soportados por el software IC-Prog.

: = - al
'S [C-prog L USE - Mrodpsipsielur e uraigiings J Id

Archivo  Edicion Bufer Ajustes Comando  Herramientas  Yer  Avuda

=-Ed TF % %%%w &5 [Ficieras —JRJ X

Figura 1.47 El nombre del dispositivo seleccionado aparece en la ventana

5. Elegir el oscilador que va a utilizar el microcontrolador en cuestién
(LP, RC, XT, HS). Para ello en la ventana Oscilador se elige el tipo

XT (oscilador a cristal de cuarzo) figura 1.48.
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Y [C-Mynu | UGE = Mygarsi il e uruigijnes J 'L_]

Archiva  Edicion Bufer Ajustes Comando  Herramientas  Wer  Avuda
=-H TF % %% % G PIC 16784 B %
Direccidn - Cadigo programsa Configuracion
0000: 3FFF 3IFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF ¥y Vvyvvy Oaciladar
0008: 3FFF 3IFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF ¥y vwyvvy
b
0010: 3IFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF vy
0018: 3IFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF  nnnyrng
0020: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF vy
0028: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF  $yWyvivy
0030: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF  $yWyvivy
0038: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 9y vivy
0040: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF ¥yvvyvvy
0048: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF ¥y vvyvvy Bits configuracion:
0050: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF ¥y vvyvvy v DT
0058: 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF ¥y vvyvvy - -

Figura 1.48 Seleccion del tipo de oscilador y de los bits de configuracion.

6. A continuacién es necesario activar los Bits de configuracion que
permiten seleccionar varias configuraciones del dispositivo (figura

1.48). En la pantalla de IC-Prog se muestra tres:

«  WDT (Watchdog Timer).

Habilitacion de Watchdog, En aplicacion sencilla se deshabilita.

* PWRT (Power-up Timer).

Temporizador al encendido. En aplicacion sencilla se activa.

* CP (Code Protect).

Proteccion de codigo de programa. Cuando se programa la proteccion
del cédigo, no es posible leer el contenido de la memoria, de tal manera
que el cbédigo del programa no se puede copiar, ni alterar, aunque si se
puede volver a borrar completamente todo el microcontrolador. En

aplicaciones sencillas se suele deshabilitar.
7. El IC-Prog ya ésta en condiciones de proceder a la grabacion de

datos en el dispositivo insertado en el programador. Para ello, en la

pantalla de edicidon se escribe los datos del programa de control a

79



grabar. O se puede cargar estos datos mas eficazmente a partir de

un archivo, sin necesidad de teclear.

= [E-F g L UGE — Mpogdragador da uruiaiiuos
Archivoa  Edicion  Bufer Ajustes Comando  Herramientas  Yer  Avuda

= -l T E | % % % Y | BE

Direccion - Codige Configurar el hardwarel

0000: 3IFFF 3JFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3JFFF
0008 : 3IFFF 3JFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3JFFF
0010: 3IFFF 3JFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3JFFF

= B[]
PIC 16F34 -] EX
Configuracian
m O=ciladaor:
e L - |

Figura 1.49 Datos a grabar en el microcontrolador

8. Para proceder a la grabacién del chip basta con activar el menu

Comand > Programa todo (figura 1.50) o bien pulsar la tecla de funcion

F5. El chip comenzara a ser programado con los datos cargados en el

buffer activo.

5 [E-Fyud L UaC - Py rigaidur de uruiniines

Archivo  Edicion Bufer Ajustes Herramientas  Wer Ayuda
S-F T F | e e | PIC 16754 =] 2
Direccidn - Cadign programa ) _ | Coriguracin
Programar bits corfig. F4 &
oooo: 3IFFF 3FFF 3FFF 3FFF iy Sscilador-
0008: 3FFF 3FFF 3FFF | Eorrar bodo IFFF iRV
00i0: 3FFF 3FFF 3FFF werificar blanco 3FFF iy Iﬁ'
0018: 3FFF 3FFF 3FFF werificar Fé SFEF iy
0020: 3JFFF 3FFF 3FFF JFFF Y¥yvvvvy
0028: 3IFFF 3FFF 3FFF Asistente Smartcard e I T e——
0030: 3JFFF 3JFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF Yy yyuwwwy
00358: 3JFFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF iy

Figura 1.50 Comenzar a programar el PIC16F84.

9. El proceso de grabacion se ira mostrando, tal como puede apreciarse

en la figura 1.51. El tiempo empleado en la grabacion del PIC16F84

dependera de la rapidez del ordenador con el que se esté trabajando.

Lz uositiyos PO GF B

Programando codigo (1024) bytes

Figura 1.51 Pantalla que aparecen durante el proceso de programacion y verificacion
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En caso de que la verificacion haya sido correcta, se informara de tal
hecho mediante una ventana que indicara que la verificacion es correcta y el
proceso de grabacién habra finalizado.

Si un microcontrolador esta protegido contra la lectura de cdédigo, es
decir tiene habilitada la opcion CP (Code Protect) del area de configuraciéon
(figura 1.52).

Bitz configuracion:

Figura 1.52 La proteccion del codigo puede ocasionar una pantalla de aparente error

Los datos grabados no pueden ser leidos en la fase de verificacion y, por
tanto, ésta no puede realizarse visualizando un error de verificacion, sin

embargo la grabacion puede haber sido realizada correctamente.

10.Una vez grabado el PIC16F84 se debe extraer del programa y

comprobar su correcto funcionamiento dentro del circuito.

81



CAPITULO I

DISENO DEL MARCADOR DE TIEMPO

2.1 DISENO ESTRUCTURAL

A través de un diagrama de bloques se presenta de una manera

practica el disefio del marcador de tiempo.

A

TECLADO

A

Y

Y

Y

PIC16F84

A
Y

A

A

A

A

Figura 2.1 diagrama de bloques de un marcador de tiempo programable
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2.2 DETALLE DE LAS PARTES QUE SE SOLUCIONARA MED IANTE
HARDWARE.

2.2.1 TECLADO MATRICIAL

Los sistemas con microcontroladores tienen como finalidad el proceso
de datos esto se lo obtiene a través de una forma manual o automatica por
medio de sensores que midan pardmetros fisicos, en este caso va a ser de
una forma manual por que los datos van a ser suministrados por el usuario a

través de un teclado matricial.

Un teclado matricial estd constituido por una matriz de pulsadores
dispuestos en filas y columnas cuyo objetivo es reducir el nimero de lineas

necesarias para su conexion

A continuacion se presenta la constitucion interna de un teclado matricial

hexadecimal que se utiliz en el proyecto.

o 1 2 3 TECLADO
HEX.

4 3 é 7

g g A E

C i) E F

:

1 2 3 4 5 6 7 %8

Figura 2.2 Constitucién interna de un teclado matricial hexadecimal
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2.2.1.1 ALGORITMO PARA LA PROGRAMACION DEL TECLA DO

Las técnicas de programacion usadas para explorar el teclado esta
esquematizada en el diagrama de flujo de la subrutina Teclado_LeeOrdenTecla
que lee el orden de la tecla pulsada. Se entiende como orden el nimero que le
corresponde a cada tecla leyéndola de izquierda a derecha y de arriba hacia

abajo, independientemente de la serigrafia sobre ella.

La exploracion del teclado debe deducir el orden de la tecla pulsada sin
importar lo serigrafiado sobre ella. Cada tecla tiene asignado el numero de
orden indicado y que se va contabilizando en la variable Tecl _TeclaOrden. El
programa utiliza una tabla de conversion para convertir el orden de la tecla a su

valor real para cada tipo de tecla.
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Teclado_leeOrdenTecla

A
‘ (Tecl_TeclaOrden)=0 ‘

A
‘ Fila 0=0, Resto filas=1 ‘

<

SI

A

¢Columna 1=0?

Incrementar(Tecl_TeclaOrden)

SI

A

¢ Columna 2=0?

NO

Incrementar(Tecl|_TeclaOrden)

SI

A

¢ Columna 3=0?

NO

Incrementar(Tecl_TeclaOrden)

SI

A

¢ Columna 4=0?

NO

(Tecla_TeclaOrden) (w) ‘

‘ Incrementar(Tecl_TeclaOrden)

‘ Siguiente fila=0, Resto fila=1

NO

A

¢Ultima tecla?

Carry=1
Indica que Si hat tecla pulsada

Carry=0
Indica que no hay tecla pulsada.

»

A

Return

Figura 2.3 Para la exploracion de un teclado hexadecimal
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2.2.1.2 LIBRERIA DE SUBRUTINAS

La libreria TECLADOS.INC contiene las subrutinas de control del teclado

hexadecimal.

Para la confeccion del programa se utilizaran las siguientes subrutinas:

e “Teclado_Inicializada”

Configura las lineas del puerto B segun la conexion del teclado realizado

y comprueba que no hay pulsado tecla alguna al principio.

e “Teclado_Espara DejaPulsar”

Permanece en esta subrutina mientras siga pulsando la tecla. Se utiliza

para que no repita la misma lectura varias veces.

 “Teclado_LeeOrdenTecla”

Lee el teclado obtenido en el registro W el orden de la tecla pulsada.
Ademas, posiciona el flan Carry para indicar si se ha presionado alguna tecla.

 “Teclado_LeeHex”

Lee un teclado hexadecimal de la tecla pulsada. Ademas posiciona el

flan Carry para indicar si se ha presionado alguna tecla.
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skkkkkkkkkkkkkkkkkhkhkkkkkkkkkkk 1 1 u Nkkkkkkkhkhkhkhkkhkkkhkkkkkkkkkhkkkhkhkhkhkhkkhkkkkk
: Libreria "TECLADO.INC

; Libreria de subrutinas para la gestion de un teclado organizado en una matriz

; de 4 x 4 y conectado al Puerto B

; RB4 RB5 RB6 RB7

,  RB2--> 8 | 9| 10| 11|
; e e N
,  RB3->|12 | 13|14 | 15 |
; N s b

; Los nimeros que se han dibujado dentro de cada cuadrado son el orden de
; las teclas que no tienen por qué coincidir con lo serigrafiado sobre ellas. El
; paso del numero de orden de la tecla al valor que hay serigrafiado sobre la

: misma se hace con una tabla de conversion.

- kkkkkkkkkkkkkkkkkhkkkhkhkkkkhkhkkkkkhkkkhkkhkkhkkkkkhkkkkkkhkkkhkkkkkkhkkkkkkkkhkkkkkkkkkkx
; ZONA DE DATOS

CBLOCK
Tecl_TeclaOrden ; Orden de la tecla a chequear.
ENDC
Tecl _UltimaTecla EQU d'15' ; Valor de orden de la dltima tecla
utilizada.

S u b rUtI n a"TeCI ad 0 Lee H eX"**********************************************************
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; Cada tecla tiene asignado un numero de orden que es contabilizado en la
; variable

; Tecl_TeclaOrden. Para convertir a su valor segun el tipo de teclado en

; concreto se utiliza una tabla de conversion.

; A continuacion se expone la relacién entre el niumero de orden de la tecla y

; los valores correspondientes para el teclado hexadecimal mas utilizado.

; ORDEN DE TECLA: TECLADO HEX. UTILIZADO:
; 0123 0123

; 4 56 7 4567

; 8 910 11 89 AB

; 12 13 14 15 CDEF

; Asi, en este ejemplo, la tecla "8" ocupa el orden 8, la tecla "F" ocupa el orden
15y la tecla "9" el orden 9.

; Si cambia el teclado también hay que cambiar de tabla de conversion.
; Entrada:  En (W) el orden de la tecla pulsada.

; Salida: En (W) el valor hexadecimal para este teclado concreto.

Teclado_LeeHex

call Teclado_LeeOrdenTecla ; Lee el Orden de la tecla pulsada.
btfss STATUS,C ; ¢ Pulsa alguna tecla?, ¢C=17?
goto Tecl FinLeeHex ; No, por tanto sale.

call Tecl _ConvierteOrdenEnHex ; Lo convierte en su valor real

mediante tabla.

bsf STATUS,C ; Vuelve a posicionar el Carry,
porque la
Tecl_FinLeeHex » instrucciéon "addwf PCL,F" lo pone .
a"0".
return
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Tecl_ConvierteOrdenEnHex ; Segun el teclado utilizado resulta:

addwf PCL,F

DT  Oh,1h,2h,3h ; Primera fila del teclado.
DT  4h,5h,6h,7h ; Segunda fila del teclado

DT  8h,9h,0Ah,0Bh ; Tercera fila del teclado.
DT O0Ch,0Dh,0Eh,OFh ; Cuarta fila del teclado.

Teclado_FinTablaHex
; Esta tabla se situa al principio de la libreria con el propdsito de que no supere
; la posicion OFFh de memoria ROM de programa. De todas formas, en caso
; que asi fuera visualizaria el siguiente mensaje de error en el proceso de
; ensamblado:
IF (Teclado_FinTablaHex > OxFF)
ERROR "Atencion: La tabla ha superado el tamafio de la pagina de los"
MESSG "primeros 256 bytes de memoria ROM. NO funcionara correc.”
ENDIF

; Subrutina "Teclado_Inicializa" ---------=-==-======mmmmm oo

; Esta subrutina configura las lineas del Puerto B segun la conexion del teclado

; realizada y comprueba que no hay pulsada tecla alguna al principio.

Teclado_Inicializa

bsf STATUS,RPO ; Configura las lineas del puerto:

moviw b'11110000' ; <RB7:RB4> entradas, <RB3:RB0>
salidas

movwf PORTB

bcf OPTION_REG,NOT_RBPU ;Habilita R de Pull-Up del Puerto B.
bcf STATUS,RPO ; Acceso al banco 0.

; call Teclado_EsperaDejePulsar

; return

; Subrutina "Teclado_EsperaDejePulsar"” ------------=--mmmmmmmmmmmm oo
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; Permanece en esta subrutina mientras siga pulsada la tecla.

Teclado_Comprobacion EQU b'11110000

Teclado_EsperaDejePulsar:
moviw Teclado_Comprobacion ; Pone a cero las cuatro lineas
movwif PORTB ; Puerto B.
Teclado_SigueEsperando
call Retardo 20ms ; Espera a que se estabilicen los
;niveles de tension.
movf PORTB,W ; Lee el Puerto B.
sublw Teclado_Comprobacion ; Si es lo mismo que escribi6 es .
;que ya no pulsa
btfss STATUS,Z ;tecla alguna.
goto Teclado_SigueEsperando
return
; Subrutina "Teclado_LeeOrdenTecla" --------==-===mmm oo
; Lee el teclado, obteniendo el orden de la tecla pulsada.
; Salida: En (W) el niumero de orden de la tecla pulsada. Ademas Carry se
; pone a "1" si se pulsa una tecla 6 a "0" si no se pulsa tecla
; alguna.

Teclado_LeeOrdenTecla:

clrff  Tecl_TeclaOrden ; Todavia no ha empezado a chequear
; el teclado.
moviw b'11111110 ; Va a chequear primera fila.
Tecl_ChequeaFila ; (Ver esquema de conexion).
movwf PORTB ; Activa la fila correspondiente.

Tecl_Columnal
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btfss PORTB,4 ; Chequea la 12 columna buscando un .

; cero.
goto Tecl GuardaValor ; Si, es cero y por tanto guarda su valor .
; 'y sale.
incf  Tecl_TeclaOrden,F ; Va a chequear la siguiente tecla.
Tecl_Columna2 ; Repite proceso para las siguientes
btfss PORTB,5 ; columnas.

goto Tecl _GuardaValor

incf  Tecl_TeclaOrden,F
Tecl_Columna3

btfss PORTB,6

goto Tecl GuardaValor

incf  Tecl_TeclaOrden,F
Tecl_Columna4

btfss PORTB,7

goto Tecl _GuardaValor

incf  Tecl_TeclaOrden,F
; Comprueba si ha chequeado la ultima tecla, en cuyo caso sale. Para ello
; testea si el contenido del registro Tecl_TeclaOrden es igual al nUumero de
; teclas del teclado.

Tecl_TerminaColumnas

moviw Tecl_UltimaTecla

subwf Tecl_TeclaOrden,W ; (W) = (Tecl_TeclaOrden)-Tecl_UltimaTecla.
btfsc STATUS,C ; ¢ C=07?, ¢ (W) negativo? ¢ TeclaOrden)<15?
goto Tecl NoPulsada ; No, se ha llegado al final del chequeo.

bsf STATUS,C ; Si. Va a chequear la siguiente fila.

rif PORTB,W ; Apunta a la siguiente fila.

goto Tecl ChequeaFila

Tecl_NoPulsada
bcf STATUS,C ; Posiciona C=0, indicando no ha pulsado

goto Tecl FinTecladoLee ;tecla algunay sale.
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Tecl_GuardaValor
movf Tecl TeclaOrden,W ;El orden de la tecla pulsada en (W) y sale.
bsf STATUS,C ;Como hay tecla tecla pulsada, pone C=1.
Tecl _FinTecladoLee

return

2.2.2 VISUALIZADOR LCD

Las pantallas de cristal liqguido o display LCD para mensajes tiene la
capacidad de mostrar cualquier caracter alfanumérico, permitiendo representar
la informacién que genera cualquier equipo electronico de una forma facil y

econdmica.

La pantalla consta de una matriz de caracteres distribuidos en una, dos,

tres, o cuatro lineas de 16 hasta 40 caracteres cada linea.

El proceso de visualizacion es gobernada por un microcontrolador

incorporado a la pantalla.

Su facil manejo lo hace ideal para dispositivos que necesitan una
capacidad de visualizaciobn pequefia o media, entre sus principales

caracteristicas tenemos:

e Consumo muy reducido, del orden de 7,5 mW.

« Pantalla de caracteres ASCII, ademas de las caracteristicas japoneses
Kaniji, caracteres griegos y simbolos matematicos.

» Desplazamiento de los caracteres hacia la izquierda o a la derecha.

* Memoria de 40 caracteres por linea de pantalla, visualizandose 16
caracteres por linea.

e Movimiento del cursor y cambio de su aspecto.

* Permite que el usuario pueda programar ocho caracteres.

Puede ser gobernado de dos formas principales: Conexion con bus de 4

bits, Conexién con bus de 8 bits.
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2.2.2.1 PATILLAJE

Un LCD se conecta facilmente a un microcontrolador como se
muestra en la figura 2.4.

|
2
:
i

EA4TOCET EEd

oscl
osc2

||-|:
i|Hi

Figura 2.4 Conexion del modulo LCD al PIC16F84A mediante bus de 4 lineas

En la figura 2.4 se ilustra la forma de conectar un LCD al puerto B del
microcontrolador mediante 4 lineas y sin lectura del Busy Flag lo que implicaria

utilizar el minimo posible de pines del microcontrolador para el control del
display LCD.

Las lineas del bus datos son triestados y pasan a estado de alta
impedancia cuando el LCD no esté habilitado.
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La alimentacidon es de +5V, la regulacion de contraste se realiza
mediante el voltaje obtenido al dividir los 5V con una resistencia ajustable de
10K y aplicarsela al pin VLc (VO) como se describe en la figura 2.4.

Tabla 2.1Funcion de los pines en un LMO16L

SENAL DEFINICION PINES FUNCION
DBO....DB7 | Data Bus 7....14 | Bus de Datos
E Enable 6 E=0, LCD no habilitado

E=1, LCD habilitado
R/W=0, escribe en

R/W Read/Write 5 LCD
R/W=1, lee del LCD
R/S=0, Modo
RS Register Select 4 Comando
R/S=1, Modo Caracter
Ve (VO) |Liquid cristal 3 Tension para ajustar el
driving Voltaje Contraste
Tension de
VDD Power Supli 2 alimentacion
Voltaje +5 Voltios
Vss Ground 1 Masa

2.2.2.2 MEMORIA DDRAM

El LMO16L posee una zona de memoria RAM llamada DDRAM donde se

almacenan los caracteres que se pueden representar.

Tiene una capacidad de 80 bytes, 40 por cada linea, de los cuales sélo 32 se
pueden visualizar a la vez 16 bytes por linea como se observa en la figura 2.5.
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En pantalla se visualizan 32 caracteres: 16 de cada fila

00

01

02

03

04

05

06

07

08

09

0A

0B

0oC

0D

OE

OF

40

41

42

43

44

45

46

47

48

49

4A

4B

4C

4D

4E

4F

Figura 2.5 DDRAM

Las dos direcciones mas importantes de la DDRAM son:

» Direccion 00h, que es el comienzo de la primera linea.

» Direccion 40h, que el comienzo de la segunda linea.

Cada vez que se escribe un dato en la DDRAM automaticamente se
apunta a la siguiente posicion, donde se realizara la escritura del préximo

caracter.

2.2.2.3 CARACTERES DEFINIDOS EN LA CGROM

El modulo LMO16L posee una zona de memoria interna no volatil
llamada CGROM donde se almacena una tabla con los 192 caracteres que

pueden ser visualizados.

Para visualizar un caracter debe recibir el codigo correspondiente, si
desea visualizar el caracter “A” el LCD debe recibir por el bus de datos el

codigo b"01000001” donde cada caracter tiene su representacion de 8 bits.

2.2.2.4 MODOS DE FUNCIONAMIENTO

Los modos de funcionamiento principales del LMO16L son:

2.2.2.41 Modo comando

Cuando por el bus de datos el LCD recibe instrucciones como:
“Borrar Display”

“Mover Display”
“Desplazar a izquierda”, etc.
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Para trabajar en modo comando, el pin RS debe estar a “0”, el pin R/W
también debe ser “0” para indicar que esta realizando una operacién de

escritura, una operacion en este modo tarda un maximo de 1.64 ms.

2.2.2.4.2 Modo caracter o dato

Cuando por el bus de datos el visualizador LCD recibe un caracter de
escritura en la DDRAM. Es decir, cuando se envia al LCD el caracter ASCII a

visualizar.

Para trabajar en este modo, el pin RS debe estar a “1”, el pin R/W debe
ser “0” para indicar que esta haciendo una operacion de escritura, una

operacion en este modo tarda un maximo de 40us.

2.2.2.4.3 Modo lectura del “busy flag” olcd oc  upado

En el bit 7 del bus de datos el LCD informa al microcontrolador de que

esta ocupado.

Para ello se lee el bus de datos con RS=0 y R/W=1, si el bit 7 del bus de
datos es “1” indica que la pantalla LCD esta4 ocupada realizando operaciones
internas y no puede aceptar nuevas instrucciones ni datos. Hay que esperar a
gue el Busy Flag valga “0” para enviarle la siguiente instruccion o caracter.

Este modo es muy importante ya que evita posibles problemas de
tiempo, de manera que no se realiza ninguna operacion con el LCD hasta

comprobar que no esta ocupado.

El pin R/W permite leer el registro de estado en el modo Busy Flag que
s6lo sirve para comprobar si el controlador ha terminado de realizar la

instruccion que se ha enviado y asi poder enviar mas.
Para realizar un control sencillo se puede hacer pausas después de

cada instruccion o envio de datos para no tener que leer el registro de estado,

con ello se evita el modo de lectura de Busy Flag la principal ventaja que se
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encontraria con esto se ahorrara un pin del microcontrolador porque la linea de

R/W no es necesario y se puede conectar directamente a masa.

El retardo sustituye al Busy Flag que se lo debe utilizar antes de realizar
cualquier nueva operacion con el LCD, este retardo debe ser mayor de 1,64 ms

si trabaja en modo comando y mayor de 40 us si trabaja en modo dato.

2.2.25 COMANDOS DE CONTROL

Los comandos que admite el médulo LMO16L se puede visualizar en la

siguiente tabla 2.2.

Tabla 2.2 Comando del visualizador LCD LMO016L

COMANDO RS |R/W |DB7 |DB6 | DB5 | DB4 | DB3 | DB2 | DB1 | DBO
Clear Display 0 0 0 0 0 0 0 0 0 1
Return Home 0 0 0 0 0 0 1 *
Entry Mode Set 0 0 0 0 0 0 0 1 |I/ID]| S
Display Control 0 0 0 0 0 0 1 D C B
Cursor and display shift 0 0 0 0 0 1 |SIC|R/L| * *
Function Set 0 0 0 0 1 | DL | N F * *
Set CGRAM Address 0 0 0 1 CCRAM Address

Set DDRAM Address 0 0 1 DDRAM Addres

Read Busy Flag 0 1 | BF DDRAM Addres

Write RAM 1 0 Write Data

Read RAM 1 1 Read Data

Los comandos se envian a través del bus de datos, para que el LCD lo

reconozca hay que poner la sefial RS a nivel bajo.

Para mayor comprension se a detallar los comandos y simbolos de esta

tabla:

2.2.2.5.1 Clear display (00000001)

Borra pantalla y devuelve el cursor a la posicion inicial (direccion 0 de la
DDRAM.
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2.2.2.5.2 Return home (0000001x)

Devuelve el cursor la posicion original de la DDRAM (direccion 00h)

guedando intacto su contenido.

2.2.2.5.3 Entry mode set (000001 i/d s)

Modo entrada, establece las caracteristicas de escritura de los datos

Shift e Increment/Decrement:

S=0: La informacién visualizada en pantalla no se desplaza al escribir

un caracter nuevo.
S=1: La informacion visualizada se desplaza al escribir un nuevo
caracter. La pantalla se desplaza en el sentido indicado por el bit I/D cuando el

cursor llega al filo de la pantalla.

I/D=0: Decremento de la posicién del cursor. Se decrementa el puntero
de la DDRAM.

2.2.2.5.4 Display control (00001dchb).

Control de la pantalla.

B=0: Blink OOF, no hay efecto de parpadeo del cursor.

B=1: Blink ON, efecto de parpadeo del cursor.

C=0: Cursor OFF, el cursor no se visualiza.

C=1: Cursor ON, el cursor es visualizado.

D=0: Display OFF, el display se apaga.

D=1: Display ON, el display se enciende.
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2.2.2.55 Cursor and display shift(0001s/c r/l xx)

Control de los desplazamientos del cursor y de la pantalla:

R/L=0 Left. A la izquierda.

R/L=1 Right. A la derecha.

S/C=0 El efecto de desplazamiento se aplica sélo sobre el cursor sin

alterar el contenido de la DDRAM.

S/C=1 El efecto de desplazamiento se aplica sobre todo el display .

2.2.2.5.6  Function set(001 dl n f xx)

Caracteristicas de control hardware:

F=0 Font. Caracteres de 5 x 7 puntos.

F=1 Font. Caracteres de 5 x 10 puntos.

N=0 Number Line. Pantalla de una 1 linea.

N=1 Number Line. Pantalla de 2 lineas.

DL=0 Data Length. Comunicacion con 4 bits.

Indica al display LCD que solamente se va a utilizar las lineas DB7, DB6,
DB5, y DB4 para enviarle los datos y que se hara enviando primero el nibble

alto, y a continuacion el nibble bajo del dato.

DL=1 Data Length. Comunicacion con 8 bits.
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2.2.2.5.7 Set cgram address

Se va a escribir sobre la direccion CGRAM sefalada.

2.2.25.8 Set ddram address (1ddddddd)

Esta instruccion se utiliza para modificar el puntero a la DDRAM

2.2.2.5.9 Read busy flag

Lee el BF indicando si hay una operacion interna en curso y lee,

ademas, el contenido de la direccion DDRAM apuntada.
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Figura 2.6 Caracteres definidos dentro de la tabla CGROM
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3.1 SOFTWARE QUE HACE FUNCIONAR AL SISTEMA

A continuacién se indica todos los pasos que se siguié para la elaboracién del
software el mismo que hace funcionar de una manera precisa y esperada de
acuerdo a las expectativas.

skkkkkkkkkkkkkhkkkhkkkhkkkhkkkkkkhkkkhkkhkkhkkhkkhkkkkkkhkkhkkkhkkkhkkhkkkkkhkkkhkkkkkkkkhkkkkkkkkkk
’

; Programa para un marcador de tiempo programable en tiempo real con
; puesta en hora.

; Visualiza los datos a través de un LCD.

; La actualizacion del reloj se lo consigue mediante un teclado.

; El marcador de tiempo programable contiene diez tiempos libres en el cual el
; usuario puede hacer usos de el de acuerdo a su necesidad.

skkkkkkkkkkkkkkkkkhkkkkkkkkhkkkkkhkkhkkhkkhhkkkkkhkkhkkhkkkhkkhkhkkkkhkkkhkkkkkkkkhkkkkkkkkkk
’

list p=16F84A ; list directive to define processor
#include <p16F84A.inc> ; processor specific variable definitions

__CONFIG _CP_OFF & _WDT_OFF & PWRTE_ON & _XT_0OSC
;' CONFIG' directive is used to embed configuration data within .asm file.
; The lables following the directive are located in the respective .inc file.
; See respective data sheet for additional information on configuration word.

; VAR IAB L E D E FI N IT I O N S********************************************
w_temp EQU 0x0C ; variable used for context saving
status_temp EQU Ox0D ; variable used for context saving

CBLOCK OxOE
Horas, Minutos, Segundos, Aux_Tiempo
Cont, Cont_OnOff, Reg_dlyl, Reg_dly2, Reg_dly3
LCD_AUX, LCD_ADDR, BANDERAS, MODO, MODO_AUX
Cont_char, Aux_Macro, TECLA, TECLA_ANT, Dato_AuxH, Dato_AuxL
Num_Alarma, Num_Alarma_Aux
Horas_Al, Minutos_Al, Cont_Alarma

ENDC

#define LCD_RS PORTA, 0
#define LCD_E PORTA, 1
#define LCD_PORT PORTB
#define _Txt 0

#define _Txt2 1
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#define _TxtOnOff 2

LCD_TXT MACRO Direccion, Texto
LOCAL Txt_Macro, lazo _lcd_txt, fin_lcd_txt, Txt

:bcf  INTCON, GIE
moviw Direccion
call LCD_REG

clrf  Cont_char

lazo_lcd_txt
moviw HIGH Txt
movwf PCLATH

movf Cont_char, W
call Txt _Macro
movwf Aux_Macro
xorlw \n’

btfsc STATUS, Z
goto fin_lcd_txt

movf Aux_Macro, W
call LCD_DATO
incf  Cont_char, f
goto lazo_lcd_txt

Txt_Macro
addlw LOW Txt
btfsc STATUS, C
incf  PCLATH
movwf PCL
Txt
DT Texto
fin_lcd_txt
; bsf INTCON, GIE
ENDM
; kkkkkkkkkkkkkkkkkkkkkkhhkkkhkhkkkhhkkkkkhkkkkhkkkkkhkkkkhkkkkhhkkkhkkhhkkkkkkkkk
ORG 0x000 ; processor reset vector
goto main ; go to beginning of program
ORG 0x004 ; interrupt vector location
movwf w_temp ; save off current W register contents
movf STATUS,w ; move status register into W register
movwf status_temp ; save off contents of STATUS
register
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; isr code can go here or be located as a call subroutine elsewhere

btfss INTCON, TOIE
goto $+3

btfsc INTCON, TOIF
goto interrup_t0

btfss INTCON, RBIE
goto $+3

btfsc INTCON, RBIF
goto interrup_rb

fin_interrup

movf status_temp,w
movwf STATUS

contents

main

swapf w_temp,f
swapf w_temp,w

BANKSEL TRISA

clrf TRISA

moviw b'11110000
movwf TRISB

moviw b'00000110
movwf OPTION_REG

BANKSEL INTCON
cif PORTA

bsf  INTCON, TOIE
bsf INTCON, GIE

moviw -.78
movwf TMRO
moviw .100
movwf Cont
clrff Horas

clrf  Minutos
clrf  Segundos

cif MODO
bsf BANDERAS, Txt

bsf BANDERAS, Txt2
call LCD_INI

; retrieve copy of STATUS register
; restore pre-isr STATUS register

; restore pre-isr W register contents
retfie ; return from interrupt
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cirf TECLA
clrf TECLA_ANT

Loop
clf PORTB
bsf INTCON, RBIE

Loop?2
btfss BANDERAS, _Txt
goto Loop2
bcf INTCON, RBIE
bcf BANDERAS, _Txt
clrf PCLATH
movf MODO, W
addwf PCL, f
goto MODOO
goto MODO1
goto MODOZ2
goto MODO3
goto MODO4
goto MODOS5
goto MODOG6
goto MODO7
goto MODOS8
goto MODO9
goto MODO10
goto MODO11

btfss BANDERAS, Txt2

goto L1_MODOO

bcf BANDERAS, Txt2

moviw 0x01

call LCD_REG

LCD_TXT 0x86,"HORA\n"
L1_MODOO

call Mostrar_Hora

movf Segundos, f
btfss STATUS, Z
goto Loop

clrf  Num_Alarma_Aux

Loop_Verif_Alarma
movf Num_Alarma_Aux, W
incf - Num_Alarma_Aux, f
call EEPROM_READ
xorwf Horas, W
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btfss STATUS, Z
goto L1 Verif_Alarmal

movf Num_Alarma_Aux, W
incf  Num_Alarma_Aux, f
cal EEPROM_READ
xorwf Minutos, W

btfss STATUS, Z

goto L1 Verif_Alarma2
bsf PORTA, 2

moviw .10
movwf Cont_Alarma
goto Loop

L1 Verif_Alarmal

incf - Num_Alarma_Aux, f

L1 Verif_Alarma2

moviw .10

xorwf Num_Alarma_Aux, W
btfss STATUS, Z

goto Loop_Verif_Alarma
goto Loop

btfss BANDERAS, _Txt2
goto L1_MODO1

bcf BANDERAS, Txt2
call TXT_IGUALAR

L1_MODO1

movwf Dato_AuxH
movwf Dato_AuxL
moviw .30
movwf Cont_OnOff
call  Mostrar_Hora
goto Loop

MODO4 moviw 0xC4

goto MODO6+2

MODO5 moviw OxC7

goto MODO6+2

MODOG6 moviw OxCA

goto MODO6+2

;.05 cambiar para 5 segundos

;.05 cambiar para 5 segundos
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call
btfsc
goto
movf
call
movf
call
goto

moviw

call

moviw

call
goto

MODO7

moviw

call
call

decf

LCD_REG
BANDERAS, _TxtOnOff
$+6

Dato_AuxH, W
LCD_DATO

Dato_AuxL, W
LCD_DATO

Loop

LCD_DATO

LCD_DATO
Loop

0x01
LCD_REG
TXT_ALARMA

Num_Alarma, W

addwf Num_Alarma, W
addlw -1

call

EEPROM_READ

movwf Horas_Al

decf

Num_Alarma, W

addwf Num_Alarma, W

call

EEPROM_READ

movwf Minutos_Al
call Mostrar_Alarma
goto Loop
MODOS8
MODO9
btfss BANDERAS, Txt2
goto L1_MODOS8
bcf BANDERAS, Txt2
moviw 0x01
call LCD_REG
call TXT_IGUALAR_A
moviw
movwf Dato_AuxH
movwf Dato_AuxL
moviw .30
movwf Cont_OnOff
L1 MODOS8
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call Mostrar_Alarma
goto Loop

MODO10
moviw 0xC6
goto MODOG6+2

MODO11
moviw 0xC9
goto MODOG6+2

; remaining code goes here

TXT_IGUALAR
LCD_TXT 0x82,"AJUSTAR HORA\n"
return

TXT_IGUALAR_A
LCD_TXT 0x80,"AJUST. ALARMA \n"
goto TXT2_ALARMA
return

TXT_ALARMA
LCD_TXT 0x84,"ALARMA \n"
TXT2_ALARMA

movf Num_Alarma, W
sublw 0x0A

btfss STATUS, Z
goto $+6

moviw 1

call LCD_DATO
moviw ‘0

call LCD_DATO
goto $+6

moviw ‘0'

call LCD_DATO
movf Num_Alarma, W
addlw 0x30

call LCD_DATO

return

Mostrar_Alarma
moviw 0xC6
call LCD_REG

movf MODO, W
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xorlw 8
btfss STATUS, Z
goto L1 Mostrar_HorasA

btfss BANDERAS, _TxtOnOff

goto L1 Mostrar_HorasA

moviw "

call LCD_DATO

moviw '

call LCD_DATO

goto L2 Mostrar_HorasA
L1 Mostrar_HorasA

swapf Horas_Al, W

andlw OxOF

addlw 0x30

call LCD_DATO

movf Horas_ Al, W

andlw Ox0F

addlw 0x30

call LCD_DATO
L2 Mostrar_HorasA

moviw
call LCD_DATO

movf MODO, W

xorlw 9

btfss STATUS, Z

goto L1 Mostrar_MinutosA

btfss BANDERAS, _TxtOnOff

goto L1 Mostrar_MinutosA

moviw "

call LCD_DATO

moviw "

call LCD_DATO

goto L2 Mostrar_MinutosA
L1 Mostrar_MinutosA

swapf Minutos_Al, W

andlw OxOF

addlw 0x30

call LCD_DATO

movf Minutos_Al, W

andlw OxOF

addlw 0x30

call LCD_DATO
L2_Mostrar_MinutosA

return
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Mostrar_Hora
moviw 0OxC4
call LCD_REG

movf MODO, W

xorlw 1

btfss STATUS, Z

goto L1 _Mostrar_Horas

btfss BANDERAS, _TxtOnOff
goto L1 Mostrar_Horas
moviw "
call LCD_DATO
moviw '
call LCD_DATO
goto L2_Mostrar_Horas
L1 Mostrar_Horas

swapf Horas, W
andlw OxOF

addlw 0x30

call LCD_DATO

movf Horas, W

andlw OxOF

addlw 0x30

call LCD_DATO
L2_Mostrar_Horas

moviw :
call LCD_DATO

movf MODO, W

xorlw 2

btfss STATUS, Z

goto L1 Mostrar_Minutos

btfss BANDERAS, TxtOnOff
goto L1 Mostrar_Minutos
moviw "
call LCD_DATO
moviw '
call LCD_DATO
goto L2_Mostrar_Minutos
L1 Mostrar_Minutos

swapf Minutos, W
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andlw OxOF
addlw 0x30
call LCD_DATO

movf Minutos, W

andlw OxOF

addlw 0x30

call LCD_DATO
L2_Mostrar_Minutos

moviw :
call LCD_DATO

movf MODO, W

xorlw 3

btfss STATUS, Z

goto L1 Mostrar_Segundos

btfss BANDERAS, _TxtOnOff
goto L1 Mostrar_Segundos
moviw "
call LCD_DATO
moviw '
call LCD_DATO
return
L1 Mostrar_Segundos

swapf Segundos, W
andlw OxOF

addlw 0x30

call LCD_DATO

movf Segundos, W
andlw Ox0F

addlw 0x30

call LCD_DATO
return

interrup_t0
moviw -.78
movwf TMRO

decfsz Cont, f
goto fin_Cont
moviw .100

movwf Cont
call Inc_tiempo

movf MODO, f
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btfsc STATUS, Z
bsf BANDERAS, Txt

decfsz Cont_Alarma, f
goto fin_Cont
bcf PORTA, 2

fin_Cont
movf MODO, f
btfsc STATUS, Z
goto fin_tO

moviw 7
xorwf MODO, W
btfsc STATUS, Z
goto fin_tO

decfsz Cont_OnOff, f
goto fin_tO

moviw .30

movwf Cont_OnOff
bsf BANDERAS, Txt
moviw 1<<_TxtOnOff
xorwf BANDERAS, f

fin_tO
bcf INTCON, TOIF
goto fin_interrup

interrup_rb
movf TECLA, W
movwf TECLA_ANT
call decod_tecla
movwf TECLA

movf TECLA, W
xorwf TECLA_ANT, W
btfsc STATUS, Z
goto fin_rb

bsf BANDERAS, _Txt
bsf BANDERAS, _Txt2
bsf BANDERAS, _TxtOnOff

movf TECLA, W

xorlw A
btfsc STATUS, Z
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goto TeclaA

movf TECLA, W
xorlw 'B'

btfsc STATUS, Z
goto TeclaB

movf TECLA, W
xorlw 'F'

btfsc STATUS, Z
goto TeclaF

movf TECLA, W
xorlw 'C'

btfsc STATUS, Z
goto TeclaC

movf TECLA, W
xorlw 'D'

btfsc STATUS, Z
goto TeclaD

movf TECLA, W
xorlw 'E'

btfsc STATUS, Z
goto TeclaE

moviw {0}
subwf TECLA, W
btfss STATUS, C
goto $+5

movf TECLA, W
sublw '9'

btfsc STATUS, C
goto TeclaNum

fin_rb

Tecl

bcf  INTCON, RBIF
goto fin_interrup

aA
moviw
movwf Dato_AuxH
movwf Dato_AuxL
movf MODO, f ; MODO=07?

btfss STATUS, Z
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goto $+4

moviw 3
movwf MODO
goto fin_rb

movf MODO, W
xorlw 1

btfss STATUS, Z
goto $+4

moviw 0
movwf MODO
goto fin_rb

movf MODO, W
xorlw 2

btfss STATUS, Z
goto $+4

moviw 1
movwf MODO
goto fin_rb

movf MODO, W
xorlw 3

btfss STATUS, Z
goto $+4

moviw 2
movwf MODO
goto fin_rb

movf MODO, W
xorlw 4

btfss STATUS, Z
goto $+4

moviw 0
movwf MODO
goto fin_rb

movf MODO, W
xorlw 5

btfss STATUS, Z
goto $+4

moviw 1
movwf MODO
goto fin_rb

movf MODO, W
xorlw 6

btfss STATUS, Z
goto fin_rb
moviw 2

; MODO=1?

; MODO=27?

; MODO=3?

; MODO=47

; MODO=5?

; MODO=67
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Tecla

movwf MODO

goto fin_rb

B

moviw "
movwf Dato_AuxH
movwf Dato_AuxL
movf MODO, f
btfss STATUS, Z
goto $+4

moviw 1
movwf MODO
goto fin_rb

movf MODO, W
xorlw 1

btfss STATUS, Z
goto $+4

moviw 2
movwf MODO
goto fin_rb

movf MODO, W
xorlw 2

btfss STATUS, Z
goto $+4

moviw 3
movwf MODO
goto fin_rb

movf MODO, W
xorlw 3

btfss STATUS, Z
goto $+4

moviw 0
movwf MODO
goto fin_rb

movf MODO, W
xorlw 4

btfss STATUS, Z
goto $+4

moviw 2
movwf MODO
goto fin_rb

movf MODO, W
xorlw 5

; MODO=07?

; MODO=1?

; MODO=27?

; MODO=3?

; MODO=47

: MODO=5?
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btfss STATUS, Z

goto $+4

moviw 3
movwf MODO
goto fin_rb

movf MODO, W
xorlw 6
btfss STATUS, Z

goto $+4

moviw 4
movwf MODO
goto fin_rb

movf MODO, W
xorlw 7
btfss STATUS, Z

goto $+4

moviw 8
movwf MODO
goto fin_rb

movf MODO, W
xorlw 8
btfss STATUS, Z

goto $+4

moviw 9
movwf MODO
goto fin_rb

movf MODO, W
xorlw 9

btfss STATUS, Z
goto $+4

moviw 7
movwf MODO
goto fin_rb

movf MODO, W
xorlw .10

btfss STATUS, Z
goto $+4

moviw 9
movwf MODO
goto fin_rb

movf MODO, W
xorlw .11
btfss STATUS, Z
goto $+4

; MODO=67

; MODO=7?

; MODO=8?

; MODO=8?

; MODO=107?

; MODO=117
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moviw 7
movwf MODO
goto fin_rb

TeclaC
movf MODO, W : MODO=7?
xorlw 7
btfss STATUS, Z
goto fin_rb

decf Num_Alarma, f

movf Num_Alarma, f
btfss STATUS, Z

goto fin_rb

moviw Ox0A

movwf Num_Alarma

goto fin_rb

TeclaD
movf MODO, W : MODO=77?
xorlw 7
btfss STATUS, Z
goto fin_rb

incf Num_Alarma, f
moviw 0x0B
xorwf Num_Alarma, W
btfss STATUS, Z

goto fin_rb
moviw 0x01
movwf Num_Alarma
goto fin_rb

TeclaE
movf MODO, W ; MODO=0?
btfss STATUS, Z
goto $+6
moviw 7
movwf MODO
moviw 0x01
movwf Num_Alarma
goto fin_rb
clrf  MODO
goto fin_rb

TeclaF

bsf BANDERAS, _Txt
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bsf BANDERAS, Txt2

bsf BANDERAS, TxtOnOff
movf MODO, W

xorlw 1

btfss STATUS, Z

goto $+3

moviw 2

movwf MODO

movf MODO, W
xorlw 2

btfss STATUS, Z
goto $+3

moviw 3
movwf MODO

movf MODO, W
xorlw 3

btfss STATUS, Z
goto $+3

moviw 0
movwf MODO

movf MODO, W

xorlw 4

btfss STATUS, Z

goto L4 TeclaF

movf Dato_AuxH, W
addlw -0x30

movwf Aux_Tiempo

moviw

xorwf Dato AuxH, W
btfsc STATUS, Z
clrf  Aux_Tiempo
swapf Aux_Tiempo, f

movf Dato_AuxL, W
addlw -0x30
addwf Aux_Tiempo, f

movf Aux_Tiempo, W
sublw 0x23

btfss STATUS, C
goto $+3

movf Aux_Tiempo, W
movwf Horas
moviw 2

movwf MODO
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L4 _TeclaF
movf MODO, W
xorlw 5
btfss STATUS, Z
goto L5 TeclaF
movf Dato_AuxH, W
addlw -0x30
movwf Aux_Tiempo

moviw

xorwf Dato AuxH, W
btfsc STATUS, Z
clrf  Aux_Tiempo
swapf Aux_Tiempo, f

movf Dato_AuxL, W
addlw -0x30
addwf Aux_Tiempo, f

movf Aux_Tiempo, W
sublw 0x59
btfss STATUS, C
goto $+3
movf Aux_Tiempo, W
movwf Minutos
moviw 3
movwf MODO

L5 TeclaF
movf MODO, W ; MODO=67?
xorlw 6
btfss STATUS, Z
goto L6 TeclaF
movf Dato_AuxH, W
addlw -0x30
movwf Aux_Tiempo

moviw

xorwf Dato AuxH, W
btfsc STATUS, Z
clrf  Aux_Tiempo
swapf Aux_Tiempo, f

movf Dato_AuxL, W
addlw -0x30
addwf Aux_Tiempo, f

movf Aux_Tiempo, W
sublw 0x59
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btfss STATUS, C

goto $+3
movf Aux_Tiempo, W
movwf Segundos
moviw 0
movwf MODO
L6 TeclaF
movf MODO, W ; MODO=107?
xorlw .10

btfss STATUS, Z

goto L10 TeclaF

movf Dato_AuxH, W
addlw -0x30

movwf Aux_Tiempo

moviw

xorwf Dato AuxH, W
btfsc STATUS, Z
clrf  Aux_Tiempo
swapf Aux_Tiempo, f

movf Dato_AuxL, W
addlw -0x30
addwf Aux_Tiempo, f

movf Aux_Tiempo, W

sublw 0x23

btfss STATUS, C

goto $+4

movf Aux_Tiempo, W

movwf Horas_ Al

call Guardar_Horas_Al

moviw 9

movwf MODO
L10 TeclaF

movf MODO, W ; MODO=11?

xorlw .11

btfss STATUS, Z

goto L11 TeclaF

movf Dato AuxH, W

addlw -0x30

movwf Aux_Tiempo

moviw "
xorwf Dato_AuxH, W
btfsc STATUS, Z
clrf  Aux_Tiempo
swapf Aux_Tiempo, f
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movf Dato AuxL, W
addlw -0x30
addwf Aux_Tiempo, f

movf Aux_Tiempo, W
sublw 0x59
btfss STATUS, C
goto $+4
movf Aux_Tiempo, W
movwf Minutos_Al
call Guardar_Minutos_Al
moviw 7
movwf MODO

L11 TeclaF

goto fin_rb

TeclaNum
movf MODO, W : MODO=17?
xorlw 1
btfss STATUS, Z
goto $+3
moviw 4
movwf MODO

movf MODO, W : MODO=2?
xorlw 2

btfss STATUS, Z

goto $+3

moviw 5

movwf MODO

movf MODO, W : MODO=3?
xorlw 3

btfss STATUS, Z

goto $+3

moviw 6

movwf MODO

movf MODO, W : MODO=8?
xorlw 8

btfss STATUS, Z

goto $+3

moviw .10

movwf MODO

movf MODO, W : MODO=9?
xorlw 9
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btfss STATUS, Z
goto $+3

moviw A1
movwf MODO

moviw
xorwf Dato AuxH, W
btfsc STATUS, Z

goto $+4

moviw

movwf Dato_AuxH

movwf Dato_AuxL

movf Dato_AuxL, W

movwf Dato_AuxH

movf TECLA, W

movwf Dato_AuxL

goto fin_rb
decod_tecla

call DLY1ms

moviw b'00001110

movwf PORTB
btfss PORTB, 4

retiw 'O’

btfss PORTB, 5

retiw '1'

btfss PORTB, 6

retiw '2'

btfss PORTB, 7

retiw '3

call DLY1ms

moviw b'00001101"

movwf PORTB
btfss PORTB, 4

retiw '4'

btfss PORTB, 5

retiw '5'

btfss PORTB, 6

retiw '6'

btfss PORTB, 7

retiw '7'

call DLY1ms

moviw b'00001011"

movwf PORTB
btfss PORTB, 4
retlw '8’
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btfss PORTB, 5

retiw '9'

btfss PORTB, 6

retiw ‘A’

btfss PORTB, 7

retiw 'B'

call DLY1ms

moviw b'00000111"

movwf PORTB
btfss PORTB, 4
retiw 'C'

btfss PORTB, 5
retiw 'D'

btfss PORTB, 6
retiw 'E'

btfss PORTB, 7
retiw 'F'

cif PORTB

rettw O

Inc_tiempo
incf  Segundos, f
movf Segundos, W
sublw 0x09
btfsc STATUS, DC
goto $+3
moviw 0x06
addwf Segundos, f
movf Segundos, W
sublw 0x59
btfsc STATUS, C
return
clrff  Segundos
incf  Minutos, f
movf Minutos, W
sublw 0x09
btfsc STATUS, DC
goto $+3
moviw 0x06
addwf Minutos, f
movf Minutos, W
sublw 0x59
btfsc STATUS, C
return
clrf  Minutos
incf  Horas, f
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movf Horas, W
sublw 0x09

btfsc STATUS, DC
goto $+3
moviw 0x06
addwf Horas, f
movf Horas, W
sublw 0x23

btfsc STATUS, C
return

clrf  Horas
return

DLY1ms
moviw 249
movwf Reg_dlyl
nop
decfsz Reg_dly1, f
goto $-2
return

DLY15ms
moviw 15
movwf Reg_dly2
call DLY1ms
decfsz Reg_dly2, f
goto $-2
return

DLY4ms
moviw 4
goto DLY15ms+1

DLY100us
moviw .34
movwf Reg_dly3
decfsz Reg_dly3, f
goto $-1
return

LCD_DATO
bsf LCD_RS
movwf LCD_AUX

swapf LCD_AUX, W
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movwf LCD_PORT

bsf LCD_E
nop
bef LCD_E

movf LCD_AUX, W
movwf LCD _PORT
bsf LCD_E

nop

bcf LCD_E

call DLY4ms

return

LCD_REG
bef  LCD_RS
goto LCD_DATO+1

LCD_INI
call DLY15ms

bef  LCD_RS

moviw b'0011"
movwf LCD_PORT

bsf LCD_E
nop

bcf LCD_E
call DLY4ms

moviw b'0011'
movwf LCD_PORT
bsf LCD_E

nop

bcf LCD_E

call DLY100us

moviw b'0011"
movwf LCD_PORT
bsf LCD_E

nop

bcf LCD_E

call DLY100us
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moviw b'0010'
movwf LCD_PORT
bsf LCD_E
nop
bcf LCD_E
call DLY100us
moviw b'00101000' ; Function Set
call LCD_REG
moviw b'00001100" ; Display ON/OFF
call LCD_REG
moviw b'00000001" ; Clear Display
call LCD_REG
moviw b'00000110" ; Entry Mode Set
call LCD_REG
return

EEPROM_READ
bcf STATUS, RPO : Banco O
movwf EEADR X
bsf STATUS, RPO : Banco 1
bsf EECON1, RD ; Start read operation
bcf STATUS, RPO : Banco O
movf EEDATA, W W = EEDATA
return

EEPROM_WRITE
bsf STATUS, RPO : Banco 1
btfsc EECON1, WR ; Esperar fin
goto $-1 ; de escritura
bcf STATUS, RPO : Banco O
movwf EEADR
bsf STATUS, RPO :Bank 1
bsf EECON1, WREN ;Enable writes
moviw 0x55 :‘Write 55h to
movwf EECON2 :EECON2
moviw OxAA ‘Write AAh to
movwf EECON2 :EECON2
bsf EECON1, WR
bcf EECON1, WREN
bcf STATUS, RPO : Banco O
return

Guardar_Horas_Al
movf Horas_ Al, W
movwf EEDATA
decf Num_Alarma, W
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addwf Num_Alarma, W
addiw -1

call EEPROM_WRITE
return

Guardar_Minutos_Al
movf Minutos_Al, W
movwf EEDATA
decf Num_Alarma, W
addwf Num_Alarma, W
call EEPROM_WRITE
return

ORG 0x2100
DE 09,10,10,30,11,00,11,30,12,00
DE 13,00,13,30,14,00,14,30,15,00

END ; directive 'end of program’

3.2 DISENO TECNICO

3.2.1 CALCULO DE LAS POTENCIAS REQUERIDAS PARAEL CORRECTO
FUNCIONAMIENTO ELECTRICO DEL SISTEMA.

Para el calculo de potencia se basa en las caracteristicas eléctricas maximas
admisibles para el microcontrolador PIC16F84 con una frecuencia de 4 MHz,
donde se toma en consideracion la corriente maxima de salida en alto por el
conjunto del puerto A mas la corriente maxima de salida en bajo por el conjunto

del puerto B y las corrientes de de Vss y Vdd:

100mMA+150mA+150mA+100mA=500 mA

Con este calculo podemos deducir que el fusible ideal en la entrada del circuito
es de 500mA.

Para la proteccion del circuito del relé se implanta un fusible de 5 A por lo que
en nuestra sirena ya esta especificado por el fabricante.
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3.2.2 DISENO DE LA FUENTE DE PODER.

Para la fuente de poder del circuito se utilizé un transformador de 110 VAC que
modifica la sefial a 9 VAC, la sefial ingresa a través de un puente de diodos el
cual entrega una sefal rectificada de 12VDC la cual ingresa a un grupo de
condensadores para eliminar el rizado de la sefial, se utilizd6 un diodo zener de
5.1V para modificar la sefial de 12 VDC a 5.1VDC como se puede observar en

la figura 2.7.

La ventaja que presenta la fuente de poder es que a través de esta fuente se
puede alimentar el circuito del PIC16F84 con los 5.1VDC vy al circuito del relee
con los 12VDC.

 FIC

'
e

[ oy iJX X __I_v "
CEP i T T

Figura 2.7 Fuente de alimentacién para el marcador de tiempo

3.2.3 CONSTRUCCION DEL PROTOTIPO.

Para la construccion del prototipo se basa en la figura (2.11) que muestra de
una manera detalla todos los elementos utilizados en el proyecto denominado
marcador de tiempo programable, el mismo que sirve para armar en las placas
disefias anteriormente y encontrar dafos, realizar modificaciones en caso de

gue se necesitara.
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Figura 2.11 Diagrama del marcador de tiempo

Una vez ya disefiado el circuito y tenerlo en placas el siguiente paso es soldar
todos los elementos que se va a utilizar para este paso es muy conveniente
polarizar adecuadamente los elementos a utilizar en caso de que sea
conveniente y antes de ponerlos verificar que estén en buen estado para luego
no tener inconvenientes en el resultado final, debe verificar que no estén
haciendo corto entre los elementos y que la suelda sea limpiada correctamente

para que no exista desgaste de la suelda en el futuro.

Antes de soldar el PIC no olvidar grabarlo como se lo indicé anteriormente y

verificar que todos sus pines estén en buen estado.

3.2.4 DISENO DE LOS CIRCUITOS IMPRESOS.

Para la elaboracién de los circuitos impresos se utilizé el software Circuit
Marke, una vez ya completado el trabajo con dicho software se ingresa al
estudio de fotograbado en el cual se obtiene la placa lista para soldar todos los

elementos que estan en el circuito

129



el o @ B ol o e o | o B el el

Figura 2.8 Circuito impreso para el funcionamiento del PIC16F84
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Figura 2.9 Circuito impreso para el control de la sirena
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3.2.5 DISENO DE UNA CAJA QUE CONTENDRA LOS CIRCUI TOS

La caja que contiene los circuitos esta disefiada para poderlo abrir con
facilidad en caso de que exista una averia en el circuito, en la parte exterior
estd compuesta por un LCD para poder visualisar los tiempos de alarma y la
hora programada, ademas consta de un teclado el cual se utiliza para ingresar

tiempos de alarma requerido y hora fijada.

LcD
i

v

TECLADO SIREH A
\ ALAFNA

ENTRADA o |1 lal 3
1107

=>—

Figura 2.10 disefio de la caja que contiene el marcador de tiempo programable
En el interior de la caja contiene dos placas una que contiene el LCD y

comanda todo el programa, y la segunda placa que contiene el relé la misma

qgue pone en funcionamiento la sirena.

131



4 PRUEBAS DE FUNCIONAMIENTO Y MANUAL DE OPERACIO N

4.1 PRUEBA DE CADA UNO DE LOS BLOQUES FUNCIONALE S DEL
SISTEMA.

En las pruebas funcionales del sistema se empieza probando la fuente
de poder que tenga los 5.1 voltios que es la base fundamental para la
alimentacion del PIC16F84 una vez ya probado esto a través de un multimetro
digital se instala el circuito del marcador de tiempo programable.

Para probar el correcto funcionamiento del software apoyandose en el
programa Proteus el cual permite simular el programa y verificar si cumple con

las expectativas propuestas.

Ya probado el programa en Proteus se lo graba en el PIC16F84 y con un
cronOémetro se verifica el tiempo estipulado en el programa que es de diez
segundos para la duracion de cada tiempo de programacion, a través de esto

se asegura que los tiempos son correctos.

A través de estas pruebas se asegura que el marcador de tiempo

programable funcionara con éxito.

4.2 PRUEBAS ESTATICAS DEL SISTEMA EN CONJUNTO

Para las pruebas estéaticas es necesario un medidor de continuidad con
el cual se puede verificar continuidad en cada una de las pistas que se utiliza
en el sistema, al momento de presentarse un corto o separacion entre pistas es

necesario corregir para el correcto funcionamiento del sistema.

Concluido con éxito las pruebas estaticas se procede a soldar los materiales

requeridos, en ciertos materiales verificando la polaridad si lo tienen.

4.3 PRUEBAS DINAMICAS DEL SISTEMA EN CONJUNTO

Se verifica el voltaje requerido a la salida de la fuente de poder, el voltaje en la

alimentacion del PIC y del LCD, en las siguientes pruebas se puede dar cuenta
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que la placa esta soldada correctamente y cumple con lo requerido para el

funcionamiento del sistema.

4.3 MANUAL DE OPERACION PARA EL MARCADOR DE TIEM PO
PROGRAMABLE.

A continuacion se explicard de una manera detallada el correcto

funcionamiento para manipular el marcador de tiempo programable.

Cuando se enciende el marcador de tiempo programable se vé la
imperiosa necesidad de ajustar una hora para ello se sigue los siguientes

pasos.

Presione la tecla B y ajuste la hora.
Para ajustar minutos presione la tecla F y ajuste los minutos.

Para ajustar segundos presione la tecla F y ajuste segundos.

A

Para que muestre la hora ya fijada presiono la tecla F.

Para ingresar a los tiempos de alarma:

Presione la tecla E.

Para observar los tiempos de alarma.

1. Presione latecla C y da una visualizacién descendente.
2. Presione latecla D y da una visualizacion ascendente.

Para ajustar la alarma a los tiempos que sean requeridos, seleccione la

alarma con las teclas ya indicadas C y D una vez ya seleccionado.
1. Presione latecla B y le permite ajustar la hora.

2. Presione la tecla F y le permite ajustar minutos.

3. Para que muestre la alarma ya fijada presione la tecla F.
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Para seguir ajustando los tiempos de memoria seleccione con las teclas
DyC.

Para salir del modo de alarma.

1. Presione la tecla E.

Una vez ya fuera del modo de alarma entra en el modo reloj.
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CAPITULO I

CONCLUSIONES

> La culminacién de este proyecto dentro del Colegio Jan Amés Comenius
ayudara a realizar el cambio de horas de una manera automatica sin tener que

depender del recurso humano para realizar dicha funcion.

> Con la ejecucion del proyecto se obtiene un sistema que permite
informar a todos los docentes de su inicio y fin de hora clase.

> Con la utilizacion del PIC16F84 se pudo satisfacer completamente con
todas las expectativas requeridas para este proyecto por que nos permite

intervalos de tiempos exactos y no existe retrasos en cambios de hora.

> Se pudo conocer de manera real como trabajan los microcontroladores y
a través de esto seguirnos involucrando mas en el mundo de la electronica y a
su vez poder palpar de una manera real como la tecnologia sigue avanzando

rapidamente y debemos actualizados para poder ser tiles a la sociedad.

> Con la implementacion del proyecto ayudara que no exista molestias
entre docentes, el marcador de tiempo programable nos proporciona cambios
de hora para que cada docente se pueda orientar su tiempo de hora clase.

> El presente trabajo ha servido como instrumento para poner en practica
los conocimientos adquiridos durante nuestra formacion en la Carrera de
Avibnica y da la pauta para aseverar que la formacion tedrica recibida mas la
aplicacion de la misma en la vida diaria, a través de practicas, permitiran hacer
de los alumnos de nuestra escuela y del instituto en general, profesionales de

alta calidad.
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RECOMENDACIONES

> Con la adecuada manipulacion del marcador de tiempo programable

alargara la vida util del proyecto ya mencionado.

> El marcador de tiempo programable debe estar en un lugar fijo donde
se pueda manipular facilmente y protegido de las inclemencias del

tiempo.

> La sirena se la debe ubicar en un lugar despejado y de esta manera no

afectar la salud auditiva de los que estan involucrados en la escuela.

> Tomar todas las medidas de seguridad que estén al alcance para poder
salvaguardar nuestra integridad personal, no solo en la elaboracion de este

proyecto sino también en futuros trabajos a realizar.

> En la informacion que se maneja en el manual de operacion tiene que
ser lo mas claro posible con el fin de que cualquier persona que no tenga
conocimientos de electronica pueda manipular sin ningin problema el

marcador de tiempo programable.
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GLOSARIO

AUTOMATIZAR
Convertir ciertos movimientos corporales en movimientos automaticos o

indeliberados.

CARGA

Cantidad de electricidad acumulada en un cuerpo

CICLO
Conjunto de una serie de fendmenos u operaciones que se repiten

ordenadamente.

CIRCUITO
Conjunto de conductores que recorre una corriente eléctrica, y en el cual hay
generalmente intercalados aparatos productores o consumidores de esta

corriente.

DESBORDANTE

Que sale de sus limites o de la medida

FICHERO

Conjunto organizado de informaciones almacenadas en un soporte comun.

INTENSIDAD ELECTRICA
Magnitud fisica que expresa la cantidad de electricidad que atraviesa un
conductor en la unidad de tiempo. Su unidad en el Sistema Internacional es el

amperio.

INTERVALO

Espacio o distancia que hay de un tiempo a otro o de un lugar a otro.
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MAPEAR

Localizar y representar graficamente la distribucion relativa de las partes de un
todo.

MODULAR
Modificar los factores que intervienen en un proceso para obtener distintos

resultados.

NIBBLES
Medios bytes

PERIODO
Espacio de tiempo que incluye toda la duracion de algo.

PIC

Control Interfase Periférico

TEMPORIZADOR
Sistema de control de tiempo que se utiliza para abrir o cerrar un circuito en
uno 0 mas momentos determinados, y que conectado a un dispositivo o pone

en accion.

TENSION

Voltaje con que se realiza una transmision de energia eléctrica.

VOLATIL

Mudable, inconstante.
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